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Before you begin

3is learner guide is based on the unit of competency BSBITU201 Produce simple 
word processed documents, Release 2. Your trainer or training organisation must 
give you information about this unit of competency as part of your training 
program. You can access the unit of competency and assessment requirements at: 
www.training.gov.au.

How to work through this learner guide

3is learner guide contains a number of features that will assist you in your 
learning. Your trainer will advise which parts of the learner guide you need to 
read, and which practice tasks and learning checkpoints you need to complete. 3e 
features of this learner guide are detailed in the following table.

Feature of the 

learner guide

How you can use each feature 

Learning content Read each topic in this learner guide. If you come across content that 

is confusing, make a note and discuss it with your trainer. Your trainer 

is in the best position to offer assistance. It is very important that you 

take on some of the responsibility for the learning you will undertake.

Examples and 

case studies

Examples of completed documents that may be used in a workplace 

are included in this learner guide. You can use these examples as 

models to help you complete practice tasks and learning checkpoints.

Case studies highlight learning points and provide realistic examples of 

workplace situations.

Practice tasks Practice tasks give you the opportunity to put your skills and knowledge 

into action. Your trainer will tell you which practice tasks to complete.

Video clips Where QR codes appear, learners can use smartphones 

and other devices to access video clips relating to the 

content. For information about how to download a QR 

reader app or accessing video on your device, please visit 

our website: www.aspirelr.com.au/help

Summary Key learning points are provided at the end of each topic.

Learning 

checkpoints

There is a learning checkpoint at the end of each topic. Your trainer will 

tell you which learning checkpoints to complete. These checkpoints 

give you an opportunity to check your progress and apply the skills and 

knowledge you have learnt.
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Foundation skills

As you complete learning using this guide, you will be developing the foundation 
skills relevant for this unit. Foundation skills are the language, literacy and 
numeracy (LLN) skills and the employability skills required for participation in 
modern workplaces and contemporary life.

3e following table outlines speci/c foundation skills noted for your learning in 
this learner guide. 

Foundation skill area Foundation skill description

Reading  • Recognises textual information within organisational 

and task requirements to determine work 

requirements

Writing  • Records numerical and textual information in 

accordance with requirements of task

Oral communication  • Participates in a variety of spoken exchanges with 

relevant personnel in an effort to clarify document 

purpose, audience and presentation requirements

Navigate the world of work  • Recognises and follows explicit and implicit protocols 

and meets expectations associated with own role

Interact with others  • May seek guidance from more experienced work 

colleagues

Get the work done  • Understands functions and features of speci�c 

computer software and uses these to perform work 

tasks
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Before you begin

What do you already know?

Use the following table to identify what you may already know. 3is may assist you 
to work out what to focus on in your learning.

Topic Key outcome Rate your con�dence 

in each section

Topic 1 Prepare to 

produce documents

1A Use safe work practices  Con�dent

 Basic understanding

 Not con�dent

1B Identify the purpose, audience 

and presentation requirements 

for a document

 Con�dent

 Basic understanding

 Not con�dent

1C Identify requirements for 

document layout and design
 Con�dent

 Basic understanding

 Not con�dent

Topic 2 Produce 

documents

2A Use appropriate software 

functions to format a document
 Con�dent

 Basic understanding

 Not con�dent

2B Identify and manipulate screen 

display options and controls
 Con�dent

 Basic understanding

 Not con�dent

2C Overcome problems with 

document presentation and 

production

 Con�dent

 Basic understanding

 Not con�dent

Topic 3 Finalise 

documents

3A Preview, check, adjust and print a 

�nal document
 Con�dent

 Basic understanding

 Not con�dent

3B Prepare documents within time 

lines and requirements
 Con�dent

 Basic understanding

 Not con�dent

3C Name and store documents, and 

exit the application safely
 Con�dent

 Basic understanding

 Not con�dent
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Topic 1 
Prepare to produce documents

Organisations require di;erent types of word processed documents to carry out 
their operations. Before you can produce a word processed document, you need 
to /nd out why the document needs to be created. You have to clarify exactly 
what kind of information has to be in the document. You also need to /nd out 
who the intended audience is; for example, it may be for internal or external 
clients. Organisations use many types of documents, such as reports, letters, faxes 
and memos. Make sure you know your organisation’s preferred presentation 
style. To create word processed documents, you may have to use templates that 
prede/ne your organisation’s style. Or, you may have to design a template to 
the organisational speci/cations outlined by your manager. Whatever type of 
document you are producing, you need to con/rm its requirements.

3is unit is designed to give you an overview of how to operate Microso& Word 
2013, and uses the Windows operating system.

In this topic you will learn how to:

1A Use safe work practices

1B Identify the purpose, audience and presentation requirements for a document

1C Identify requirements for document layout and design
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Workplace safety is everyone’s responsibility. Employers and employees must make 
an active contribution to ensuring their workplace is safe. Hazards need to be 
identi/ed and risks assessed to reduce injury in the workplace. If you are working 
at a computer for an extended period each day, your workstation must be 
comfortable and designed for you to carry out your tasks eDciently. You will need 
to organise your work so that you are not doing a repetitive task for a long time. 
You should also take time to stand up and stretch. 

Another consideration in the 
workplace is to use resource 
conservation techniques 
to prevent wastage. Most 
organisations require sta; 
to follow resource-saving 
procedures such as turning o; 
lights in unused rooms and 
recycling paper. You need to 
be aware of any conservation 
e;orts made by your 
organisation.

Workplace safety legislative requirements

All work health and safety (WHS) legislation requires employers to provide 
a safe workplace and adequate training and supervision, while controlling 
workplace hazards and risks. You must work in line with legislative requirements, 
regulations, Australian and industry standards, and the relevant codes of practice.

WHS legislation describes the legal requirements for ensuring workplaces are safe 
and healthy, such as:

• managing risks to health and safety

• promoting and maintaining the health, safety and welfare of people at work

• protecting people at work from injury and illness, including 
psychological injury

• protecting the health and safety of the public in workplaces

• consulting workers and encouraging participation in maintaining WHS

• providing rehabilitation and maximum recovery for injured workers.

1A Use safe work practices



Unit release 2 (Aspire Version 1.1)
© Aspire Training & Consulting

3

Topic 1
Prepare to produce documents

WHS policy 

All workplaces in Australia are required to have a WHS policy that describes the 
organisation’s responsibility for the health and safety of its employees. 3e policy 
should include the organisation’s goals and objectives regarding WHS and a 
general set of guidelines related to health and safety in the workplace.

3e WHS policy will help you ful/l your duty of care as a worker for the 
organisation.

WHS procedures

WHS procedures are instructions developed to ensure all employees work safely 
and e;ectively. In the context of working in an oDce and using a computer 
workstation, the following information should be contained in an organisation’s 
WHS procedures.

Information contained in WHS procedures includes:

• workstation ergonomics

• standard safety precautions and housekeeping

• safe handling of hazardous substances (e.g. cleaning products)

• emergency and /re drills

• hazard identi/cation and risk control

• manual handling

• emergency contact numbers, including local doctors and hospitals

• location of /rst-aid equipment and /rst-aid oDcers.

WHS regulations 

3e WHS legislation of each state or territory is supported by regulations and 
codes of practice. 3e WHS regulations support the legislation by outlining 
speci/c workplace health and safety requirements that must be addressed.

3e Model WHS regulations, which provide a framework that most states and 
territories have adopted, have speci/c requirements for hazardous manual tasks 
that must be addressed. 3ese requirements are summarised below.

Manage risk

A person conducting a business or undertaking must manage 

risks to health and safety relating to a musculoskeletal disorder 

associated with a hazardous manual task, in accordance with 

guidelines for managing risks to health and safety.
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Control measures

In determining the control measures to implement, the person 

conducting the business or undertaking must have regard to 

all relevant matters that may contribute to a musculoskeletal 

disorder, including:

 • postures, movements, forces and vibration relating to the 

hazardous manual task

 • the duration and frequency of the hazardous manual task

 • workplace environmental conditions that may affect the 

hazardous manual task or the worker performing it

 • the design of the work area

 • the layout of the workplace

 • the systems of work used

 • the nature, size, weight or number of persons, animals or things 

involved in carrying out the hazardous manual task.

Code of practice: hazardous manual tasks

3e WHS regulations determine that it is a legal requirement for the person 
conducting a business or undertaking (PCBU) and workers to address hazardous 
manual tasks in the workplace. A PCBU has a broad de/nition that includes both 
employers and supervisors.

3e code of practice for hazardous manual tasks was developed to provide 
guidance on how to manage risks associated with those manual tasks with the 
potential to cause musculoskeletal disorders (MSDs).

A PCBU must consult with workers, so far as it is reasonably practical, to develop 
their own set of procedures to manage the risk of MSDs.

3e hazardous manual tasks code of practice helps PCBUs and workers to:

• identify hazardous manual tasks

• assess the risks

• control the risks

• review the control measures.

Musculoskeletal disorders

MSDs come about in two main ways:

• Gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs 
through repeated or continuous use of the same body parts, including static 
body positions

• Sudden damage caused by strenuous activity or unexpected movements, such 
as when loads being handled move or change position suddenly
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3e repetitive movements and sustained body position associated with entering 
data into a computer is regarded as a hazardous manual task and puts the operator 
at risk of developing an MSD. 

MSDs may include conditions such as: 

• sprains and strains of muscles, ligaments and tendons

• back injuries, including damage to the muscles, tendons, ligaments, spinal 
discs, nerves, joints and bones

• joint and bone injuries or degeneration, including injuries to the shoulder, 
elbow, wrist, hip, knee, ankle, hands and feet

• nerve injuries or compression (e.g. carpal tunnel syndrome)

• muscular and vascular disorders as a result of hand-arm vibration

• so& tissue hernias

• chronic pain.

Standard precautions

Your workplace may need you to use standard 
precautions, particularly work practices related to 
the prevention of repetitive strain injuries (RSIs). 
3ese include ergonomic practices, workstation 
design, enforced breaks and exercise routines.

Workers in an oDce environment follow standard 
precautions when using a computer workstation. 
However, research on sitting has demonstrated 
that other precautions also need to be considered, 
such as the use of standing workstations, to 
ensure that injuries are prevented. It is important 
that you carefully follow any standard precautions 
that are prescribed for your workplace.

Equipment and systems safety checks

An important part of your daily work routine is to check the various systems and 
equipment you will use during the day to make sure they are in correct working 
order. Your workplace policies and procedures should include the steps to follow. 
You may need to perform this procedure at the start of your working day or at 
speci/ed intervals during the day.

Workstation safety procedure/checklist:

• Seat is positioned in front of your computer and you can reach your keyboard 
comfortably.

• Computer monitor is positioned out of direct sunlight and at the correct 
height. 
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• Environment is dust-free as dust can a;ect the monitor or central processing 
unit of a computer.

• Cables are secured so no-one trips over them.

• Blinds and window coverings are used to reduce glare and heat at your 
workstation.

• Temperatures don’t exceed 26°C and humidity is between 40 and 60 per cent.

Use ergonomic practices in the workplace

3e aim of ergonomics is to reduce the risk of 
accidents, injury and ill health by applying safe work 
practices. Ergonomics is about creating comfortable 
working conditions by adapting workstations, tools 
and equipment to an individual worker’s needs. It 
also improves performance and productivity in the 
workplace. Ergonomics covers all aspects of working, 
from physical stresses such as sitting at a workstation 
all day to environmental factors such as noise, air-
conditioning and lighting.

Set up your workstation

A workstation includes a computer, screen, keyboard, mouse, desk and chair. How 
your workstation is designed can a;ect your health and wellbeing. Several physical 
problems can result from poor workstation design; for example, lower back strain 
may result from sitting  in a chair that does not support your back. Below are some 
guidelines for setting up your workstation to be ergonomically eDcient.

Chair

Adjust your chair height so that your feet are �at on the �oor, your 

thighs are horizontal and your lower legs are vertical to the �oor.

Adjust the backrest by raising it to the maximum height and 

then lower it until it �ts the curve of your lower back. If this is not 

comfortable, lower it another couple of centimetres. Continue this 

until a comfortable position is found. The backrest should support 

your lower back.

The backrest may also be adjusted backwards and forwards. 

When seated in your usual working position, move the backrest 

until it exerts a gentle pressure on your lower back. Make sure 

there is at least two centimetres of space between the front of the 

seat and the back of your knees. Armrests should be positioned so 

that they do not interfere with carrying out your tasks.
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Desk

When you sit at your desk, the surface should be just below your 

elbow height. If your desk is not height-adjustable, try to raise your 

chair so you are sitting at the correct height, and use a footrest to 

make up the difference. If your desk is too low, you may be able to 

extend the legs. You should have plenty of leg space underneath 

your desk. Don’t clutter the space with bags and bins, as your 

legs may become cramped and your posture twisted. Position any 

equipment or materials you use so that you can reach them easily 

without twisting. For example, stationery items you frequently use 

should go in the top desk drawer, and your keyboard and screen 

should sit directly in front of you to avoid having to angle or twist 

your body.

Keyboard

The angle of your keyboard can be adjusted to suit your comfort 

level by moving the supports underneath it. Place the keyboard as 

close as possible to the front of your desk. Don’t place documents 

between yourself and the keyboard, as stretching will eventually 

cause muscle strain in your arms, shoulders and neck. While 

typing it is best not to rest your wrists, as they should not be bent 

up, down, or to the side. The knuckle, wrist and top of the forearm 

should form a straight line. Wrist supports or rests give you a place 

to rest your hands only when pausing from typing, not while you 

are typing. Do not pound the keys; use a light touch. Leave enough 

room on your desk to put the keyboard out of the way when you 

are not using it.

Mouse

Place the mouse and mouse mat directly beside your keyboard on 

the side you prefer. If you use the mouse frequently, you could try 

to alternate sides. You will be surprised at how easy this becomes 

with practice. Your wrist should be straight, and the desk should 

support the weight of your wrist, not your arm. Try to keep your 

wrist �at and rest your �ngers on the mouse between clicks. Hold 

the mouse lightly. Don’t hold onto the mouse when you are not 

using it.
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Screen

Once you have adjusted your chair and desk, you can position 

your screen. Adjust it so that the top of the screen is level with or 

slightly lower than your eyes. If you can’t adjust the screen to the 

correct height, place the screen on a platform.

The screen should be at least 50 centimetres or an arm’s 

length away from your seated position to minimise radiation 

exposure; however, you should always adjust the position of the 

screen to suit you. It is best to position the screen so that you 

can clearly read the text without leaning forward, twisting your 

neck, or looking too far upwards. Also take surrounding factors 

into consideration, such as re�ection, glare and shadow, when 

positioning your screen.

Workstation features

3e features of an ergonomic workstation are highlighted in the diagram below. 
Some features of the workstation may vary depending on the type of computer 
work being performed. Graphic work may require the use of a pen tool, and 
multiple monitors are commonly used for a variety of digital work.

Top of screen The screen angle should be adjustable between 85 and 125 

degrees to the horizontal. 

Centre of screen Minimise screen re�ection and glare by using an anti-glare �lter.

Bottom of screen Place a document holder beneath or beside the screen at the 

same viewing distance as the screen.

Top line of sight The viewing distance should be between 400 mm and 700 mm.

Bottom line of sight A relaxed viewing angle is approximately 35 degrees.

continued …
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… continued

Head Keep your head erect.

Shoulder Have your upper arms hanging freely.

Elbow Have your forearms approximately horizontal.

Above knee Ensure there is clearance between the lower edge of the desk and 

your legs.

Below knee Ensure there is clearance between the front edge of the seat and 

the lower leg.

Footrest Use a footrest if needed.

Back of chair The back support should be adjusted to support the small of your 

back.

Under chair Adjust the seat height to suit your furniture and equipment.

Chair legs Use a chair with a �ve castor base.

Desktop layout

Items on your desk, including equipment and resources, should be arranged 
within easy reach.

Your desk area can be divided into three zones:

• the optimum reach zone – the area closest to you, where your hands operate 
most of the time

• the maximum reach zone – further away, but still close enough to reach 
comfortably

• the outer reach zone – where you may have to bend forward or stand to 
reach items.

Make sure your desk is organised so that frequently used objects, such as your 
keyboard, are close to you. Intermittently used objects, such as your phone, should 
be out of the way but still within easy reach. Other resources used less frequently, 
such as in- and out-trays, should be in the outer reach zone.
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Adjust your equipment and posture

When your posture is poor, you may su;er from aches and pains. Spending a long 
time in the same position can put stress on your body and this can be made worse 
if you are in an uncomfortable or poorly supported position. 3ese symptoms may 
start out very slight, but if you continue to use poor posture they may get worse 
and become intolerable. 3ey may result in cumulative stress given the constant 
stress on your muscles, nerves or tendons. When setting up your workstation, 
you need to make sure your posture will not cause you pain or discomfort. 3e 
equipment you use needs to be adjusted to suit your body shape and size, and the 
tasks you are doing.

You have already looked at adjusting your screen and chair. 3ere are other oDce 
tools that can help your posture. 3ese include the following items.

Document holders

Document holders are designed to 

hold papers and reference material in 

a convenient position for viewing. Place 

your document holder in the correct 

position. If it is below the screen or too 

far off to the side, each time your eyes 

look from one source to the other, your 

pupils have to adjust. Doing this for long 

periods of time can cause headaches 

and eyestrain. Place the document 

holder at a similar level, angle and 

distance as the screen to avoid having 

to shift eye focus.

Angle boards

Angle boards allow the user to maintain 

correct posture when reading, by 

reducing the angle between the work 

surface and the vertical posture. 

Adjustable to a suitable height 

and angle, these supports enable 

comfortable reading with the neck 

correctly positioned. Try to keep your 

neck as straight as possible when you 

are reading.

Footrests

A footrest may be necessary if you can’t 

place your feet comfortably on the �oor. 

Footrests allow your feet to rest at the 

correct height and on a tilting angle, 

which prevents strain on the lower 

back. 

Headsets

If you use a telephone for long periods 

of time, it is a good idea to use a 

headset. A headset will keep your neck 

straight and your arms free. Headsets 

prevent you from bending your neck to 

support the telephone handpiece.

Home o2ce

Communication technology and organisational policies to maintain a 
sustainable work–life balance are creating opportunities for more Lexible 
working arrangements. 3is means that more employees are working from 
home oDces or in other remote oDce locations. Many bene/ts can be derived 
from Lexible working arrangement for employers and employees, but there is 
still a responsibility for all parties to make sure that home and remote oDces use 
ergonomic practices and follow WHS requirements.
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Hot desking

Hot desking is an oDce organisation system that is used in some workplaces where 
workstations are not assigned to an individual worker. Workstations may be used 
by multiple workers during di;erent time periods or shi&s. 

3e motivation behind hot desking is primarily the cost savings achieved by 
setting up fewer workstations in workplaces where not all the workers are in the 
oDce at the same time, or not in the oDce for long periods at a time. 

Another common adaptation of hot desking is where work stations are assigned 
to individual workers, but need to be readily available for other workers to access 
based on daily work requirements, such as a group of people coming together to 
work on a speci/c project.

WHS and workplace culture considerations with hot desking

 • It is common for workers to want their own space. Consequently, they may tend to 

choose one location and stick to it.

 • It can take extra time each day to set up a work station for ergonomic and work 

ef�ciency. 

 • Personal hygiene needs to be maintained to prevent the spread of germs on keyboards 

and desk surfaces.

 • Workstations need to be tidied appropriately in readiness for the next user. This can 

also involve some cleaning.

Standing desks

Sitting at a desk for long periods of time has 
many negative health impacts. It is claimed that 
the negative e;ects of prolonged sitting cannot be 
counteracted by regular exercise and that the only 
way to eliminate this problem is to avoid sitting as 
much as possible. 

3ese negative health impacts can be overcome 
through the use of standing desks. Standing 
provides a greater opportunity for your body to 
move and adjust and involves more muscular 
activity than sitting.

Some of the health bene/ts from standing 
include:

• alleviating back pain and other repetitive stress injuries by greater use of core 
back muscles to support the upper body

• increasing focus, alertness and activity level by releasing restless energy

• reducing the risk of developing cardiovascular disease, diabetes and blood 
clots, which can be caused by prolonged sitting.
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Standing desk ergonomics

Using a standing desk for hours on end requires you to adapt. It is recommended 
that you start using a standing desk gradually by alternating between sitting 
and standing. You may experience sore feet, tired legs and fatigue at /rst. Wear 
comfortable shoes and use an anti-fatigue Loor mat.

An ergonomically designed standing work desk means you can maintain correct 
posture while working. 

Position arms at 90 degrees when typing/standing.

Place the computer screen at eye-level and tilting it slightly upwards.

Place the computer monitor at least an arm’s length away.

Avoid leaning over the desk; keep your body straight. 

Monitor environmental factors

Environmental issues in the workplace include lighting, noise control and air 
quality. If the environment of your workplace is not monitored and controlled, you 
may su;er from headaches, fatigue, hearing loss or eyestrain.

Light

Good lighting is essential for a safe and hazard-free workplace. You need to see 
things clearly to work e;ectively. Simply shi&ing the screen slightly, adjusting 
blinds, altering the brightness settings on the screen and using desk lamps can 
avoid many light hazards. Try to use natural sunlight if the oDce layout can 
accommodate this. If not, keep bulbs and /xtures clean, focus light on your task 
and use Luorescent lights if possible.

Improper lighting can cause eyestrain and headaches.

Hazards associated with lighting include:

• glare – a computer screen positioned in front of a bright window can be 
diDcult to see

• Lickering lights – a Luorescent light may malfunction, causing annoyance, 
irritation and nausea

• inadequate or dim light – reading in dim light causes eyestrain

• reLections – sunlight reLecting on a screen can make it diDcult to read

• shadows – shadows shi&ing across your work area can cause you to sit with 
bad posture in order to read your work.
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Noise

Noise can include any annoying or disturbing sound. Excessive noise around 
heavy machinery or equipment can cause permanent hearing loss. Noise is a 
problem if it disturbs people, distracts them, interferes with communication, 
causes people stress or generally interferes with their work.

Many oDces are open-plan in design, o&en with employees seated close to each 
other and divided by partitions at chest or head height. 3ink about noise levels 
when you set up your workstation. It should be possible for people in open-plan 
oDces to have some privacy when they are on the telephone and carrying out their 
day-to-day activities.

Noise in the oDce can come from:

• machines (photocopiers, fax machines, printers)

• other equipment (telephones, paging systems, music)

• background noise (li&s, air-conditioning, traDc)

• people talking.

Noise management

Noise can also be a problem outside oDce environments, 
such as on factory Loors, at construction sites or near 
airports. You may have to wear ear protection if you are 
required to work in excessively noisy areas.

3ere are many ways that problem noise can be 
controlled in the workplace. Noisy machines can be put 
in a separate room or area. Sound-absorbent materials 
such as carpet and partitions can be installed or 
arranged to deLect and absorb noise. 3e volume level on your telephone’s speaker 
can be adjusted.

Remember that noise is only a hazard when it is stopping you from working 
productively, comfortably and safely. Many people prefer to work with low levels of 
noise rather than complete silence.

Air

Air-conditioned oDces do not have fresh air from open windows. 3is can cause 
problems for some people.

ODce workers frequently complain of being too hot or too cold. If a person’s desk 
is near an air-conditioning outlet, the area around their desk can be much colder 
than elsewhere in the oDce. 3ey can also su;er from dry and itchy eyes. Report 
such hazards to the relevant person. 3is situation can usually be corrected by 
adjusting air-conditioning Low.
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Organise your work

Having a well-planned workstation and comfortable surroundings is pointless if 
you don’t organise your work in a way that prevents discomfort or pain. Make sure 
you plan your daily tasks so that you aren’t doing repetitive work for long periods 
of time. Make sure you take rest breaks and exercise regularly.

Positive work organisation includes:

• a mixture of repetitive and other activities

• rest periods

• exercise breaks.

Vary your activities

Your work role may involve several di;erent tasks. Some tasks may be repetitive, 
such as typing up reports or entering data. If you are able to vary the tasks you 
carry out each day, this will help prevent repetitive actions that cause stress to 
your body. For example, if you have to enter a lot of data, break up the repetitive 
nature of the task by discussing a project with a fellow worker, collecting some 
research from the internet or doing another constructive workplace task you are 
responsible for. WorkLow should be designed to reduce the repetitive tasks given 
to particular people.

Take rest periods

All employers need to provide rest periods for employees. Rest periods include 
tea breaks and lunch breaks. During the working day everyone needs to sit down, 
breathe easily, relax and take time to think about something other than work.

Have exercise breaks

When working with a computer, you should have short breaks at regular intervals 
to combat stress and prevent pain and discomfort. As discussed previously, using 
computers for too long without breaks has been associated with back and neck 
pain, headaches, migraines and eyestrain.

Try the following exercises several times a day, and encourage 
others around you to try them. Make sure you are relaxed and 
stretch gently, without overstretching. Stop if you feel any pain 
or discomfort, and remember to exercise both sides of your body. 
Most importantly, breathe deeply and evenly throughout the 
stretch.

v1
3

2
3
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Neck Turn your head gently to look over your right 

shoulder. Hold for 10 seconds. Now roll your 

head forward to look over your left shoulder 

and hold for 10 seconds. Repeat several times.

Shoulders Sitting with a straight back and neck, roll your 

shoulders forward, then back. Repeat several 

times.

Wrists, hands and arms Interlacing �ngers, turn palms upwards. Now 

lift arms over your head and stretch, leaning 

gently to the left and then to the right. Repeat 

movement several times.

Upper and lower back In a standing position place hands in the small 

of the back. Gently arch back and hold for 10 

seconds. Repeat when needed.

Shoulders and arms Stretch your arms above your head, cradle 

your elbow with your hand and gently pull your 

elbow behind your head. Repeat on the other 

side, holding the stretch for 10 seconds.

Eyes Every 20 minutes, look away from the screen. 

Focus on a distant object (more than three 

metres away).
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Work without stress

Here are some tips for working without stress.

Tips to help minimise stress

 • Adjust your chair and desk to suit your body.

 • Position your screen to suit your posture.

 • Adjust other equipment for safe and comfortable use.

 • Reduce excess noise.

 • Ensure you have adequate light.

 • Arrange your desktop so you can access things easily.

 • Take regular breaks from your work.

 • Frequently rest your eyes.

 • Do stretching exercises.

 • Vary your tasks.

Practise conservation techniques

Conserving resources at work bene/ts not only the 
organisation by reducing costs, but also the planet by 
reducing greenhouse gases and the amount of waste 
sent to land/ll. Most organisations have policies and 
procedures for conserving resources. You can /nd out 
what these are by reading your workplace manual or 
asking your manager or colleagues.

Ways to conserve resources at work include:

• minimising paper wastage

• reducing energy use.

Minimise paper wastage

Wasting paper costs organisations and the planet a great deal. Consequently, many 
organisations have developed policies for paper usage. 3ese include:

• using both sides of the paper when photocopying

• recycling non-con/dential waste paper in recycling bins

• storing email messages in an electronic folder instead of printing

• reducing the volume of printing where possible

• reusing paper by using blank sides for rough dra&s and reusing folders 
and /les

• using recycled paper or paper from plantation timber for printed documents

• using a recycling service to collect waste paper.
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Example: o2ce paper

Using the following statistics, consider how many trees are used for of�ce paper.

How many trees are used to produce paper?

 • One ton of uncoated virgin (non-recycled) printing and of�ce paper uses 24 trees.

 • One ton of 100 per cent virgin (non-recycled) newsprint uses 12 trees.

 • One ream (500 sheets) of paper uses six per cent of a tree.

 • One tree makes 16.67 reams of copy paper, or 8,335 sheets.

 • One carton (10 reams) of 100 per cent virgin copier paper uses 60 per cent of a 

tree.

 • One ton of coated, non-recycled higher-end 

magazine paper (used for high quality photographic 

magazines) uses more than 15 trees.

 • One ton of coated, non-recycled lower-end magazine 

paper (used for news magazines and most 

catalogues) uses nearly eight trees.

The statistics in this example are based on US short 

tons (2,000 pounds), not metric tonnes.

Source: www.conservatree.com 

Minimise energy use

Wasting energy also costs organisations and the planet a great deal. Many 
organisations have developed policies and procedures to save energy. 3ese 
include:

• providing training programs on smart energy practices so that employees can 
practise energy eDciency

• turning o; equipment when not in use

• using power-save functions for equipment

• re/lling toner and ink cartridges from printers.
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Resource conservation

Here are some tips for practising conservation.

Resource conservation tips

 • Use the power-save function on printers when they are not in 

use.

 • Print and copy on both sides of the page, where possible.

 • Use recycled paper (paper used on one side) in the 

photocopier and printer for rough drafts.

 • Use recycled paper for telephone messages.

 • Place a recycling bin near the photocopier.

Practice task 1

Here is a checklist to follow when setting up your workstation. Go through the points that 

are relevant to you and make any necessary adjustments to your work or study space. 

You may need another person to help you and check your posture. If you are not able to 

tick some of the checkpoints, change your study space or discuss making alterations to 

your workstation with your manager.

Chair

 � Is the seat height-adjustable?

 � Is it high enough to allow you to sit comfortably over the keyboard?

 � Is it stable?

 � Does it swivel?

 � Is the height of the backrest adjustable and does it tilt backwards and forwards?

 � If it has arms, can you still get close enough to the desk and swivel the chair?

 � Are your feet �at on the �oor, or are you using a footrest?

 � Are you sitting up straight with the backrest �rm against your back?

Desk

 � Is it large enough to allow the screen and keyboard to be correctly positioned?

 � Is it low enough to allow you to keep your forearms horizontal or sloping downwards?

 � Is it high enough to allow your thighs to �t underneath it?

Keyboard

 � Can it be tilted to allow you to adjust it?

 � Are the symbols on the keys clear and easy to see?

 � Is there suf�cient space in front of it to allow you to correctly position your arms?

Screen

 � Does the screen have easily adjustable brightness and contrast controls?

 � Is the image on the screen stable and �icker-free?

 � Are there adjustment mechanisms to allow the screen to be tilted, swivelled or raised 

to avoid glare and re�ections and help you keep a natural and relaxed posture?

 � Are you sitting far away enough from it for comfort?
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When you word process a document, you use a computer and so&ware application 
to create a text-based document. For example, to word process a letter, you would 
type the text into Microso& Word and format it as a letter. Before you can produce 
a word processed document, you need to /nd out its purpose. Who is it for? How 
should it be presented? 3e following information contains guidelines on what 
should be considered when determining a document’s purpose, audience and 
presentation requirements.

Purpose

 └ The purpose of a word processed document varies on a case-by-

case basis. It may be an agenda for a meeting, or information for 

clients about organisational news or events. Sharing information 

is important in all organisations. Word processing is a common 

way to produce information for distribution.

 └ If you are asked to produce a word processed document, the 

�rst thing you should clarify is the purpose of the document. 

Its purpose will determine the way it is planned and designed. 

For example, if the document’s purpose is to provide detailed 

information about the progress of a project, you may need to 

collect information from colleagues before putting the document 

together.

Audience

 └ You need to be aware of your document’s audience. When you 

are producing a word processed document, keep in mind who 

it is intended for and decide how the information should be 

presented. For example, if you are developing a document for 

clients who are not familiar with its subject matter, you may need 

to avoid using jargon so they don’t become confused. You have to 

consider the information needs of the audience and how detailed 

the information should be.

Presentation requirements

 └ Most organisations have developed policies and procedures for 

how they would like word processed documents to be presented. 

How you present your document will enhance the audience’s 

ability to understand it.

1B Identify the purpose, audience and 
presentation requirements for a document
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Organisational requirements for document type 
and style

Most organisations have requirements for the style in which documents should be 
presented. 

You need to be familiar with the styles used by your organisation for each 
document type. Some organisations have developed templates to be used for word 
processing documents. A template is an established style and layout model for a 
document.

Word processed documents used by organisations can include:

• memos

• faxes

• agendas

• minutes

• reports

• brie/ng papers

• Lyers

• letters

• standard form letters

• mail merge

• labels

• envelopes.

Document templates

Templates can be formatted to any style your 
organisation prefers. Templates ensure that particular 
kinds of word processed documents are always produced 
in the same style. If you have to create a template for 
your organisation, make sure you ask your manager for 
advice about organisational style requirements. If your 
organisation has existing templates, make sure you know 
where they are stored.



Unit release 2 (Aspire Version 1.1)
© Aspire Training & Consulting

21

Topic 1
Prepare to produce documents

Memos

Look at the following example of a memo template. 3e template here can be used 
to quickly create a memo. A memo is a way to send information to people in an 
organisation.

Of�ce Memo

To:

cc:

From:

Date:

Subject:

Faxes

A fax is an electronically transmitted 
copy of a document. Sending a fax is a 
way to immediately send a hard-copy 
document from one location to another. A 
fax should have a cover sheet followed by 
the information the organisation wants to 
transmit. Your organisation may choose to 
design a fax template in a style that suits its 
requirements, or use one already available 
within its word processing so&ware. Always 
/le the faxes you send in case any issues arise 
regarding the contents.
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Create a fax

1. In the following exercise, you will create a fax using a Word fax template. Open 
Word. 

2. In Search, type Fax and enter. 

3.  Select an appropriate fax template from the list (use either Installed Templates 
or Online Templates).

4. Select Create.

5.  Spend 10 minutes entering information into the fax. 3e information can 
be anything relevant to an organisation, such as a list of sta; addresses or a 
request for leave. Save your fax as MyFax.
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Example: fax

The following example is a fax cover sheet designed by an organisation.

Western 
Importer

Paterson Road 

Melbourne 3004

Phone (03) 9620 1305

Fax: (03) 9621 4642

national@wimp.com.au

Facsimile

To: Gumboots Galore

Attention: Gavin Jones

Fax number: (03) 9873 2469

From: Cheryl Johnston

Date: 4 February 2016

Re: Monthly order

No. of pages: 3 (including this one)

Please �nd attached our order for March.

I will phone today to clarify delivery instructions.

Thanks

Cheryl

Please telephone the above number if any pages are missing.

Agendas

An agenda is a list of items to be covered at 
a meeting. It helps participants follow the 
proceedings. Agendas are also used to specify 
the events for many other sorts of business 
activities, such as talks at a conference. 

Word has Agenda templates that you can use 
to create an agenda. By selecting the File tab, 
choosing New, and Agendas, you can access 
the online agenda templates.
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Minutes

Minutes are a written record of what occurred in a meeting. A list of participants 
is recorded as well as the details of all issues discussed. Minutes are written at the 
time of the meeting and are o&en placed on a server (a computer network) where 
all employees can access them. It may be your responsibility to write meeting 
minutes, so make sure you know where to /nd previous minutes. By looking at 
previous minutes, you will /nd out how your organisation prefers to have them 
presented. Look at the following example of meeting minutes.

Example: minutes

Minutes of the monthly meeting of the Equipment Committee of Engineering Forces 

on Wednesday 20 April at 2.00 pm at 237 Fraser Street, Belton

Present

G. Jones (Chair), L. Meadows, D. Juntovski, J. Crance, A. Andrews, S. Tran, H. Roberts

Apologies

J. Rostova

Minutes of the previous meeting

The minutes of the previous meeting were con�rmed and adopted as an accurate 

record.

Correspondence

A letter was received from Century Computers ordering two computers and a modem.

A letter was sent to the Royale Receptions Centre requesting information on facilities.

Reports

G. Jones reported that the consultant from Eagle Consultancy had completed a 

report on the computer needs of the company. The �ndings will be summarised and 

distributed to all staff members.

Action: H. Roberts to prepare a summary and distribute to staff within a week.

J. Crance presented the �nancial report on spending for March. Major items were the 

coffee maker and �ling cabinet. The report was accepted.

A report from the Occupational Health and Safety Of�cer was tabled and discussion 

deferred to the next meeting.

Other business

D. Juntovski reported that the printer had consistently broken down during the previous 

three weeks and requested that the cost of getting a new printer be investigated. The 

meeting discussed the possibility of obtaining a second-hand printer.

Action: A. Andrews will obtain costs for a new printer and a second-hand printer from a 

range of suppliers and report at the next meeting.

Next meeting

The next meeting was set for Friday 29 April at 2.00 pm.
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Reports

A report is a document that outlines information about 
an activity in an organisation. A report may be written 
about the progress of an existing project, to detail 
the feasibility of a future project or to summarise the 
/ndings of research that has been undertaken. Writing 
a report is a way of communicating organisational 
information to a wide audience.

Reports o&en include many details that need to be 
collected from multiple people within an organisation. For example, multiple 
teams may be working on one project and their progress needs to be recorded in 
one report. To access a variety of report templates, open Word, select New, and 
select Installed Templates.

Example: report

Look at the following example of a report outline. Because reports are generally quite long 

and detailed, the report example is only an outline.

Wilson & Sons Pty Ltd

Report of Phase 1 of the Edition 5 Project

The Edition 5 Project is developing a new product to be ready for client sales in the 

following year.

The following Phase 1 milestones of the Edition 5 Project have been successfully 

reached:

 • Evaluation of clients’ needs has taken place.

 • Collation and analysis of the results has been completed.

 • A report into the evaluation �ndings has been released.

Phase 1 actions that need to take place include:

 • development of plans for using the evaluation �ndings in the Edition 5 Project

 • the assembly of a development team and the release of its plans in two weeks.

Brie9ng papers

A brie/ng paper provides an outline or summary of key points and information. 
Brie/ng papers are o&en used for reporting an outline of relevant issues to 
management or to colleagues at meetings. 3e point of a brie/ng paper is to 
enable readers to quickly scan the information so they can understand the 
important issues.
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Flyers

A Lyer is a piece of paper that is distributed to a wide audience to advertise an 
event, product or service. An organisation may produce a Lyer to post to clients 
to inform them of a special o;er, or to let sta; know about an upcoming event. 
3e point of a Lyer is to attract people’s attention and interest them in the Lyer’s 
subject. Look at the following Lyer.

Lunchtime staff seminar

Health and �tness 
for of�ce workers

Hayley Kings, �tness instructor from  

Loosen Up Fitness Centre

12.15 – 1.00 pm

Monday 10 October

In the Baltic Room

Letters

Organisations commonly use business letters to 
send information to internal and external clients. 
Many organisations have printed letterhead paper, 
and the information is word processed before 
being printed on the paper. An organisation 
may choose to design a letter template that suits 
its organisational style requirements or use one 
available from word processing so&ware.
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Example: letter

What sort of things may be style requirements in the following example of a letter?

Near East Trading Co

131 Victory Road

Kensington TAS 7725

Telephone: (03) 3275 9123; Fax: (03) 2175 9124

19 February 2016

Ms Peta Jones

Manager

Expo Furniture

28 Hopper Street

Cairns QLD 4870

Dear Peta,

Order Number 21560

I wish to apologise for the delivery of the damaged dining table. A credit note to the 

value of $400 is enclosed.

We are pleased to announce that our ‘Summer Selection’ is currently being �nalised. 

A catalogue is in production and should be available in about two weeks. A copy of the 

catalogue will be forwarded to you as soon as it is available.

At the beginning of March our sales representative will start showing the range to all 

our clients. You will be contacted personally to arrange an appointment to view the 

‘Summer Selection’.

We hope you will be as impressed as we are with the new range. Please contact us if 

you require any further information.

Regards,

Sophie Wilson

Brand Manager

Enc. ‘Summer Selection’ catalogue

ef25/sw/xx
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Create a letter

In the following exercise, you are required to create a letter using a Word Letter 
template.

1. Open Word.

2. In Search, type ‘Letter’ and press enter.

3. Choose an appropriate Letter template from the online template list.

 

4. Select Create.

5. Spend 30 minutes composing a letter on a subject of your choice. Save your 
letter as MyLetter.
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Standard form letters

Many organisations have standard letters for di;erent types of communication, 
including letters that are sent out regularly. Examples of standard form letters 
include acknowledgement letters, overdue payment letters and customer reward 
letters. Standard letters can be stored as a template on the computer system and 
accessed by selecting the File tab, New, and My templates.

Mail merge

3e mail merge facility in Word can be used to send the same information to a 
number of people. Mail merge is used for sales and marketing letters, evaluation-
of-service letters and newsletter distribution. It can be used for letters, envelopes 
and labels. Any information can be used as a merge, including name, address, 
postcode, customer number, amount owing and customer preference. Data used in 
the merge can be already stored via spreadsheet or database programs, or as a table 
in Word. It is possible to use either existing data or a list of data created as part of 
the mail merge process. 3e list of data that is created can be used again if further 
mail merge documents are required.

Create a mail merge letter

In the following exercise, you are required to perform a letter mail merge and 
create a data source for the merge.

1. Open the letter you created in the previous exercise and delete the details of 
the recipient. 3e letter will be used as a proforma for the merged letter that 
you are about to create.

2. Select the Mailings tab.

3. Select Start Mail Merge button and choose Letters. (It is possible to choose 
other options such as labels and envelopes.)

4. Click on Select Recipients button.

5. Select Type New List. (If there is already an existing database of contact details 
to be used access by selecting Use Existing List – select the appropriate /le. 
Next step is 8.)
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6. Record required details (Title, First Name, Last Name, etc.). 

7. If additional /elds are required, such as Postcode, you can rename a column, 
select Customize Columns, select the /eld you want to rename and click 
Rename… . If entries are not required, select Delete. When you have the 
desired /elds, click OK.

8. Details to be recorded in the Address List are as follows:

Title Mr Ms Ms

First Name John Janelle Ha

Last Name Smith Groves Duong

Company Name Green Thumbs Livestock Inc. ARV Financial

Address Line 1 12 Smith St 12 Dorset St 31 Gloster Rd

Suburb Melbourne Sydney Sydney

State VIC NSW NSW

Postcode 3000 2000 2000

9. Click OK. Save the database of the list of names as MyList.

10. To add all the /elds required for addressing the letter, place the cursor where 
you want to insert the address block. From the Mailings tab, click the Address 

Block button. Specify the address block elements and click OK. Remove the 
existing address /elds you are replacing.

11. To insert a single required /eld (for example, a greeting line), use the Insert 

Merge Field button.

12. Choose Preview results to check the layout and presentation. 

13. If you are happy with the letters, from the Home tab, select File and Print.

14. To edit each letter individually, from the Mailings tab select Finish & Merge, 
then Edit Individual Documents. 3e letters will open in a new document for 
you to edit individually. 

15. Close the letters to return to the master letter documents.

16. If you are satis/ed with the master document, from the Mailings tab select the 
Finish & Merge button. Select File and Print documents.

17. Go to the Home tab, select Save As and save the master letter as MyMerge.
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Mail merging suggestions

Here are some tips on mail merging.

Break details into small parts

 └ A common error that people make when inputting the address is 

to record all details under address line 1. Mail merge works with 

�elds, which means that all details need to be broken up into 

smaller parts to enable you to manipulate the information as you 

see �t.

Be aware of how data will appear

 └ Be aware that how you insert the merge �elds is how the data will 

appear, so if spaces or line breaks are required you will need to 

manually insert these into the document.

Printing merged document

 └ When undertaking a merge document in the workplace, there 

may be numerous letters consisting of the same information, 

addressed to different people. In most cases, a merge document 

will be sent to print with only the merged document outline, with 

the associated database being stored in the computer system.

Labels and envelopes

All organisations need to have a system for 
entering addresses for correspondence to clients 
or suppliers. An organisation may choose to enter 
addresses directly onto envelopes or to print out 
strips of labels that stick onto the envelopes.

You can use word processing so&ware to create 
labels and to print addresses onto envelopes. 
If you are responsible for large mailouts in an 
organisation, this so&ware function can save you a 
lot of time.



32
Unit release 2 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU201
Produce simple word processed documents

Word process an address on an envelope

In the following exercise, you will word process an address for an envelope.

To add an address to an envelope, you are required to use an existing letter.

1. Open your MyLetter document.

2. From the Mailings tab, it is possible to choose either the Envelopes or Labels 
button. For this activity, select Envelopes. 3e recipient’s address that you 
typed into your letter should appear in the Delivery address box. Look at the 
following example of the dialogue box to help you.

3. Under Return address, enter a return address (your organisation or home).

4. If you want to change the size of the envelope, click Options. Click Envelope 

Options and enter the correct envelope size. Click OK.

5. To print your envelope, place an envelope in the printer and click Print. Make 
sure the envelope is inserted the right way. Close your MyLetter document.
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Create a label

In the following exercise, you are required to create an address for a mailing label.

1. Create a new, blank Word document.

2. From the Mailings tab, select the Labels button.

 

3. Under Address, enter an address for your label. You can print a full page or a 
single label. For this exercise, select Single label.

4. To select a speci/c label size, click Options. Many labels have a special size 
code that Word recognises. Check the labels you are using and make sure the 
code is in the label options. Select the appropriate label size and click OK.

5. To print your label, place a label sheet in the printer and click Print. Make sure 
the sheet is inserted the right way. You don’t need to save your label.

Practice task 2

Create a database address list and mail merge document to merge the information to 

mailing labels.

 • Label details: Avery A4/A5, C2160. (If you are in a workplace, locate the reference 

details of the mailing labels that are used from the available list.)

 • Insert the address block and select the Update labels button from the Mailings tab. 

This will input all of the contact details in your merged document.

 • Select the Preview results button from the Mailings tab. Review and proofread the 

information.

 • Save the document as MyLabels.
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Most organisations require employees to adhere to speci/c layouts and designs 
when creating documents. 3is may include using standard templates or using 
corporate letterhead for certain types of documents. 

Consistent document layout and design helps to identify an organisation and 
demonstrates its professionalism and culture to those who are to receive the 
communication. It is therefore important that care is taken in design and layout, 
and that it adheres to the corporate image of the organisation that it represents.

Document layout and design may relate to such things as:

• margin width

• font and size

• spacing of text and paragraphs

• alignment of text

• use of header/footer

• document reference details

• signature blocks and document sign-o;

• use of logos and motto.

Corporate colour scheme

Some organisations stipulate strict adherence to particular colour schemes in 
the production of documents. 3is may relate to the actual production of the 
word processed document and the type of font and colours used, as well as the 
colour and type of paper used for certain correspondence. For example, some 
organisations use coloured paper with corporate letterhead for the /rst page of 
outgoing correspondence and plain paper for supplementary pages. 

Alternatively, some organisations have their own colour scheme and logos as a 
template on the system – if so, you will need to ensure you send the document to 
print to the colour printer as opposed to a black and white printer. Where possible, 
verify colour scheme requirements with your supervisor or colleagues. 3e use of 
a colour scheme helps to promote the corporate image of the organisation, and the 
scheme is usually similar colouring to that of the corporate logo.

1C Identify requirements for 
document layout and design



Unit release 2 (Aspire Version 1.1)
© Aspire Training & Consulting

35

Topic 1
Prepare to produce documents

Corporate logo

 Many organisations have guidelines 
for the use of corporate logos. 
3is may relate to logo size, colour 
and use. Particularly in larger 
organisations, it may be necessary 
to obtain permission for use of 
the logo. 3is is because a logo is 
part of an organisation’s branding. 
3erefore, the organisation needs 
to give approval for the logo’s 
use to ensure its brand is used 
appropriately and any use adheres 
to the relevant guidelines. Examples 
of when this could be necessary 
include invitation letters, sales 
campaigns and presentation material. 

For simple documents that are being produced, it is normally a matter of using 
existing templates and/or letterhead for outgoing correspondence. 3erefore 
use of the logo has already been pre-approved. Discuss the use of the logo with 
supervisors and colleagues, and refer to policy manuals if possible.

Consistent corporate image

Adhering to strict corporate image guidelines when producing documents is very 
important in some organisations. How colours and the logo are used, and the 
layout and design of a document all reLect an organisation’s image and how it is 
viewed within the marketplace. Many organisations spend money on creating a 
brand or image that is designed to send a subconscious message of what it is they 
are trying to achieve. 

3e use of a consistent corporate image reLects what the organisation considers 
important. Some organisations believe the use of colours can engender certain 
feelings or emotions; for example, blue is said to be a more ‘trusting’ colour. 
Organisations that aim to be seen as professional service providers may use a more 
traditional approach to the layout and design of documents. Organisations that 
want their image to reLect a more modern approach may have their letterhead 
with the logo and corporate details on the side of the document as opposed to the 
top. Fonts may be chosen to reLect a modern or conservative image.
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House styles

 Many organisations have style guides for producing documents. Style guides 
include rules for the type of font or layout of documents. Examples include:

• Arial 12 pt for the body text of a standard letter

• the le& margin at 4 cm

• the number of lines between text in the document (for example, the space from 
the letterhead, the number of lines from the address line to the greeting)

• /le reference details at the top of the document in italics

• the number of lines for the signature block.

In many cases, if a standard template is 
used, prede/ned styles will automatically 
appear in the document. Alternatively, an 
organisation may prefer to apply Word styles 
to documents. Clarify use of house styles for 
your organisation with your supervisor and 
colleagues.

Content restrictions

Some information that you have access to in an organisation is not for the public 
domain; for instance, information on pro/t expectations, customer contact details 
or speci/c customer buying habits. It is essential that you adhere to restrictions 
on the type of content that can be used within documents that you produce, and 
that sensitive material is not included. 3e production of documents needs to be 
tailored to the intended audience, using language and terms that they understand. 
3e use of jargon and confusing abbreviations should be avoided.

Copyright

Organisations frequently refer to copyright and use disclaimers in documents they 
produce. An organisation may follow a particular practice when using copyrighted 
material. For instance, if it is quoting from another source in the document, it may 
reference the text by author and page (for example, Smith, p. 9), and then provide 
a more detailed reference as a footnote (for example, Smith, P 2007, �e art of 
referencing, 3e Book Press, Crows Nest, NSW.).

To insert a footnote, select the References tab, select the Cross-reference button, 
select Footnote, and enter the details. You will notice that the text now has a 
number at the end of it, which refers to the footnote. 3is can be used to take you 
to the reference details.

Disclaimers are commonly used for outgoing correspondence such as emails, 
faxes and newsletters. Disclaimers generally state that the information is for the 
intended recipient only, or it may refer to the information being correct at the time 
of printing. However, further expert advice may be required before disclaimers are 
applied to a document.
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Headers and footers

Headers and footers are used to record common 
information about a document. A header is found at the 
top of the document above the top margin; a footer is 
found at the bottom of the document below the bottom 
margin. In some cases, templates may include a header 
that contains the organisation’s letterhead with a logo 
and contact details. 

You may be required to insert a header or footer that 
contains more information, including the organisation’s name, time, date, 
document title and /le name. Most of this information is available as prede/ned 
buttons or /elds; alternatively you may need to type in the information required. 
Most organisations have speci/c guidelines to follow for what is to be contained 
in the header/footer. Apart from letterhead, in many cases the information in 
the header/footer is of a smaller size to the body text, and may have a di;erent 
font applied. 3e information that appears in headers and footers is repeated 
throughout a document, or within sections of a document.

Create a header

In the following exercise, you will create a header.

1. Open your MyLetter document.

2. Select the Insert tab.

3. Select the Header button.

4. Select the style of header from the listing or select Edit Header to insert your 
own style of header.

5. You will notice that the screen options have changed to the Design tab. From 
here you can either type in the header required, or select the appropriate 
buttons to insert prede/ned /elds into your document (for example, /lename 
and date). Common buttons to use include Page Number, Date & Time, or 
Quick Parts. Type in your name and the date.

6. Once you have inserted the required header, double-click back into the main 
document.

7. Save and close MyLetter.

It is also possible to access the header/footer by double-clicking within the margin.
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Templates

Templates provide a quick and easy way to access documents that have a standard 
layout and styles. Examples include memos, letterheads, faxes, standard customer 
letters and standard sta; letters. Templates used by organisations can be created 
in-house or obtained online. 3ere is a wide range of templates available for word 
processing of documents, such as agendas, letters, memos, invoices and invitations. 
In Microso& Word 2013, the templates are available online, which means you need 
to be connected to the internet to be able to use them. Alternatively, you can access 
common templates via Installed Templates. 

Using template designs can be useful if you are not sure how to set up particular 
documents, or if you want to alter the layout of existing documents. In most 
organisations, templates are used for standard letters and documents. 3ese are 
stored in either Sample Templates or My Templates.

Creating a fax template

In the following exercise, you will create a fax using an existing template.

1. In Word, select the File tab and select New.

2. Search for Equity Fax and select the Fax cover sheet (Equity theme).

3. Select Create. 3e screen will now display a blank fax proforma that you can 
manipulate. Add clipart to the fax to represent a corporate logo by going to the 
Insert tab and choosing Online Pictures.
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4. In the Bing Image Search, type Clipart and the type of picture you’re looking 
for. For example, Clipart Garden Centre. Select an image and click Insert and 
resize the image as appropriate. Note: search results are images licensed under 
Creative Commons. Please review the speci#c licence for any image you want to 
use to ensure you can comply with it.

5. Insert a disclaimer stating that the fax is for the intended recipient only. (If 
your workplace has a speci/c disclaimer, insert it here.)

6. Save the document as a template called CompanyFax. 3e document will not 
automatically be saved as a template. Select Word template from the Save as 

type drop-down menu.

7. Create a footer that provides details of the /le reference. To use the template, 
open Word and select Custom. Select Custom O3ce Templates, then the 
template you saved. 3is will provide you with a blank proforma of the 
document, which you can use and save as appropriate.
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Practice task 3

Read the case study, then complete the questions that follow.

Case study

Isabella completed her studies in human resource management and gained a 

position as a human resources of�cer with a large multinational company. After 

working in the position for approximately six months, Isabella had impressed her 

supervisor and manager with her dedication and enthusiasm. As a reward, they 

asked her to manage a project of creating a new induction resource pack for new 

managers at the organisation. 

In her project brief, she was asked to include information on the role of human 

resources and the importance of line managers interacting with human resources 

for advice and guidance on workplace issues. At �rst Isabella wasn’t sure how 

to tackle this assignment; however, she investigated trade journals and various 

textbooks, along with the HR policy manual. Isabella located three relevant trade 

journal articles and some information on decision-making models from textbooks, 

which she believed would complement the information she had sourced from the 

HR policy manual. Isabella set about word processing the articles and models to 

make them look more appealing. 

Once complete, she signed off each document with ‘by Isabella Gonivici’. Isabella 

did not reference the articles or textbooks and did not state who had researched 

the models. In a brainwave, Isabella decided to send regular customers details of 

new managers’ after hours home phone numbers just in case they couldn’t reach 

them during the day. She thought this would complement the organisation’s policy 

of total customer service. Isabella was pleased with her work and was looking 

forward to the accolades that would follow from her supervisor and manager.

1. Were there any possible copyright infringements in Isabella’s completion of the task?

2. Were there any content restriction issues?

3. What should Isabella have done differently?



Unit release 2 (Aspire Version 1.1)
© Aspire Training & Consulting

41

Topic 1
Prepare to produce documents

Summary

1. Safe work practices – ergonomics, work organisation, and energy and resource 
conservation – enhance working conditions and help to improve the overall 
e;ectiveness and eDciency of the oDce.

2. Understanding the purpose of a word processed document leads to strong and 
e;ective communication.

3. 3e audience for a word processed document is the people who will eventually 
read it.

4. A word processed document needs to be presented in a way that meets 
organisational and task requirements.

5. Types of word processed documents used by organisations include memos, 
faxes, agendas, minutes, reports, brie/ng papers, Lyers, letters, standard form 
letters, mail merges, labels and envelopes.

6. Organisations may use a template, which is a layout model for a document. 
3ey may have designed the template themselves or they may use one that is 
included in their word processing so&ware.
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3is learning checkpoint allows you to review your skills and knowledge in 
preparing to produce documents.

Part A

1. Create a template. You can follow the requirements of your organisation, or an 
organisation you are familiar with. 3e template should be consistent with the 
organisation’s style and layout requirements.

2. Explain how you used safe work practices, including ergonomics, work 
organisation and the conservation of paper, when creating the document.

3. Explain the purpose, intended audience and presentation requirements of the 
document template you have produced. 

Learning checkpoint 1 
Prepare to produce a document
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Part B

Read the case study, then answer the questions that follow.

Case study

Angela works as an administrative assistant in a large organisation. One of her 

duties is to word process documents for internal and external circulation. One day 

her manager gives her the outline of a report that is needed for a board of directors’ 

meeting the following week.

Angela �rst clari�es with her manager why the document needs to be created, the 

level of detail required by the board of directors and the presentation requirements 

for the document. Angela also enquires about the report’s security and discovers 

that the document will contain con�dential material and should be protected at all 

times.

1. Angela clari/ed four issues before word processing the report. Describe these 
four issues.

2. Explain why it is important to understand the purpose, audience and 
presentation requirements of a document before producing a word processed 
document.
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3. Describe what things Angela would need to consider when preparing the 
design and layout of the document.

4. Describe what Angela should do to ensure she is working safely when 
producing the document.
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Part C

Write a plan for the production of a document. You can use your own workplace 
or an organisation you are familiar with. You don’t have to produce the document; 
just plan for its production.

1. Describe why this document is required by the organisation. For example, it 
might be a report about a project, a letter or a fax that needs to be sent to a 
client.

2. Explain who the intended audience for the document is.

3. Describe the presentation style required for the document.

4. Explain how the presentation style chosen will enhance the audience’s ability 
to read and understand the document.
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5. Describe what you will do to ensure you are practising workplace safety when 
producing the document.



Unit release 2 (Aspire Version 1.1)
© Aspire Training & Consulting

47

Topic 2 
Produce documents

When producing a word processed document, you should use so&ware functions 
and formatting options to ensure the document has a consistent design and layout. 
You need to check and amend documents in accordance with organisational and 
task requirements. Developing skills in proofreading and editing will help you 
produce documents that are free from errors.

Being able to use the screen display options and controls of the so&ware program 
can assist in the production of documents. Screen display options and controls 
provide you with further ability to check and proof the document before you print. 
3ey also allow you to manipulate the on-screen production of the document, as 
well as make choices about the overall appearance of the document layout.

Before printing documents, you need to preview and adjust them in order to 
produce hard-copy documents that suit organisational requirements. Manuals, 
training booklets and help desks can be used to help solve problems that arise 
when producing word processed documents.

In this topic you will learn how to:

2A Use appropriate so&ware functions to format a document

2B Identify and manipulate screen display options and controls

2C Overcome problems with document presentation and production
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Word processing functions are used so that documents have a consistent design 
and layout. Common word processing functions include formatting paragraphs, 
inserting page numbers, adjusting spacing, inserting headers and footers, and 
checking spelling and grammar.

When you open a new Word document, it will have a number of default settings 
such as font type and size, paragraph indentation and spacing. You need to be able 
to alter these settings to produce documents that suit your organisation’s style 
requirements. 

Page Setup

3e Page Layout function allows you to choose options to change the overall 
appearance of a document. 3e options you can choose include the paper size, the 
document margins, the vertical alignment of text on the page and the orientation 
of the document. As part of the Page Layout tab, there are various Page Setup tool 
buttons that enable quick and easy access to the options required to make 
alterations. You can use the Page Setup function to alter the entire document or 
just part of it.

Here are some tips for changing the page setup of your document:

• To modify the page setup of an entire document, place the pointer anywhere 
within the document.

• To modify a portion of a document, select the text you want to change by 
highlighting it.

Once you have decided which parts of the document you want to alter, select the 
appropriate Page Setup tool buttons, from the Page Layout tab.

Set margins

1. Open your MyLetter document.

2. Select the Page Layout tab, then Margins. Choose Custom Margins.

3. Adjust the margins by using the Top, Bottom, Le4 and Right boxes. Use the 
Preview display to guide your choices. Click OK. 

4. Save your changes and keep your MyLetter document open.

2A Use appropriate software functions 
to format a document
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Select paper size, source and orientation

1. In your MyLetter document, select the Page Layout tab and select the Size 
button. Make the appropriate choice for paper size.

2. From the Page Layout tab, select the Orientation button. Select Portrait from 
Orientation. 3is means that the height of the document is greater than the 
width, like a portrait painting. Landscape means the width of the document is 
greater than the height, like a landscape painting.

3. Save and close your MyLetter document.

Experiment with these options and view your document by going to File, then 
Print to see the results of your choices. If you are unhappy with your choice, you 
can undo it by using the Undo button.

Paragraph formatting

Most word processed documents are written in paragraphs and you need to 
know how to format paragraphs in accordance with your organisation’s style 
requirements. Paragraph formatting includes indents, spacing, and line and page 
breaks. 

Set indents and spacing

1. Open your MyLetter document.

2. Look at the paragraph formatting tools on the Home tab and Page Layout 
tab, including Bullets, Indentation, Sort, Show/hide paragraph marks, 
Alignment, Line spacing, Shading and Borders.

3. 3e indent of a paragraph is how far it is positioned from the margin. From the 
Home tab, use the Increase Indent button or Decrease Indent button to move 
the paragraph forward or backward.

4. Alignment controls how your paragraph text will appear. You can choose 
to align your text le&, centred, right or justi/ed. Select an alignment for your 
text. 
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5. Spacing has options for selecting spaces before and a&er each paragraph and 
between each line. From the Home tab, select Line and Paragraph Spacing 
and select Line Spacing Options from the dropdown menu. Under Spacing, 
select a space Before and A4er each paragraph. 3e number is equivalent to 
the font (letter type) size. For example, 6 pt a&er means the space between lines 
is 6 points. Keep your MyLetter document open.

Set pagination options

Pagination relates to the division of a document into pages, as in a book.

In this exercise, you are required to select a pagination option for your MyLetter 
document. Select a few paragraphs in your document before beginning this 
exercise.

1. From the Home tab, select Line and Paragraph Spacing and select Line 

Spacing Options from the dropdown menu.

2. Select the Line and Page Breaks tab. You can control where Word positions 
page breaks by using the four pagination options. You need to /rst select the 
paragraphs you want the options to control.

3. 3e Widow/Orphan control option is set by default and prevents the /rst and 
last lines of a paragraph from being positioned on the top or bottom of a page. 
Select Keep lines together to keep the lines in a paragraph together on a page 
or in a column.

4. Save and close your MyLetter document.
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Header and footer options

As discussed previously, headers and footers are used to add more information to 
a document such as the date, time and page number. A header appears at the top 
of a page and a footer at the bottom. 3e information that appears in headers and 
footers is repeated throughout a document, or within sections of a document. To 
insert a header or footer, select the Insert tab and choose either Header or Footer. 
You will notice that once you select the style of the header or footer, an additional 
tab – Design – is available for your use. 3e Design tab contains various options 
to create a header/footer that suits your document, such as a di;erent header/footer 
on odd and even pages.

Insert a header and footer

1. Open your MyLetter document. 

2. Select the Insert tab and select Header.  

3. Select the Blank style – this will allow you to enter text to the le& of the header.

Type ‘AGENDA’.

4. Select the Go to Footer button from the Design tab. 

5. Add the /le path of the document. From the Design tab, select the Quick 

Parts button and select Field. 3e following dialogue box will be displayed.

6. Select FileName, appropriate formatting and check the Add path to 7lename 
option. 3is will insert a /eld that automatically provides details of the 
document’s name and location. Click OK.

7. Save and close your MyLetter document.
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Spelling and grammar checker

Word processing so&ware has functions that allow you to check your spelling 
and grammar. Whenever you produce a word processed document, you should 
check the spelling and grammar before presenting the document to your audience. 
You can check spelling and grammar as you type or you can check the whole 
document once it has been written.

3e word processing so&ware can be set to a default dictionary, which is usually 
based on the language and country of usage; for example, English (Australia).

Check spelling and grammar as you type

In the follow exercise, you will ensure the spelling and grammar checker is 
turned on.

1. Open your MyLetter document.

2. From the File tab  , select the Options button  , and select 
Proo7ng. 

3. Under When correcting spelling and grammar in Word, select Check 

spelling as you type and Mark grammar errors as you type. Click OK.

4. Enter more text into your MyLetter document. If you make a grammatical 
error, a blue wavy line will appear underneath the error. If you make a spelling 
error, a red wavy line will appear underneath the error.

5. To do a spell check, from the Review tab select Spelling & Grammar           . 
3e spelling and grammar dialogue box will appear. 3e spelling and 
grammar function will then highlight errors and suggest spelling or 
grammatical changes. Select the most appropriate choice and click Change. 
You can also Add or Ignore words that the spell checker does not recognise. 
Keep your MyLetter document open.

An electronic spelling and grammar checker will not pick up words used 
inappropriately, only words that are spelt incorrectly, so it is best to also proofread 
your document yourself.

Document protection

Documents you create may be con/dential and thus require protection. Word 
processing so&ware includes a function for creating password protection on 
individual documents. When you make a document password protected, make 
sure you write the password down in a secure place. In the following exercise, you 
are required to make your MyLetter document password protected.

1. In your MyLetter document, go to the File tab. Info is selected by default.

2. Click Protect Document and select Encrypt with Password from the 
dropdown menu.
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3. In the Password box, type a password and click OK. 

 

Protect Document will now be highlighted in a yellow block. 

 

4. In the Con7rm password, re-enter the password and click OK.

5. Save and close your MyLetter document.

6. Reopen your document using your new password. Close your document.

 

Columns

Creating columns for some documents can be useful for presentation. Columns 
are commonly used for newsletters, reference manuals and other documents where 
you want to alter the way the information is presented. Using columns allows you 
to Low the information on a page into a series of columns, similar to that of a 
newspaper.

Corporate letterhead/logo

For many documents, such as outgoing oDcial correspondence, it is necessary to 
use letterhead. Some organisations use pre-printed letterhead, and you will need to 
ensure that the appropriate spacing and margins are used to allow for printing on 
the letterhead. If letterhead is commonly used, you may also /nd that your oDce 
uses a set printer tray for letterhead.
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Alternatively, some organisations use templates for letterhead or logo documents. 
3ese will be available to you as new documents. Select the File tab, choose New, 
and select either Sample templates or My templates. Most organisation templates 
will be available in these areas. If a common template is not listed here, speak to 
your supervisor or colleagues for guidance.

3ere may be set guidelines when using corporate logos. It may be necessary to 
seek approval for their use, and you may need to adhere to set procedures for the 
size of logos. Ask your supervisor for direction in using logos and if there are any 
speci/c procedures to be followed for your workplace. To access logos, select the 
Insert tab and select Pictures. In most cases, the logo will be available for use 
from this reference point.

Formatting a document

Most organisations have a preferred formatting style so that word processed 
documents have a consistent design and layout. You need to /nd out what your 
organisation’s preferred formatting style is. 3e following information outlines 
common formatting options.

Font type, size and colour

 A font is the style of type used in a document, such as Times New Roman, Arial 
or Book Antiqua. Fonts can have attributes such as bold, italic or underline, 
which can be used to add emphasis to words. Fonts can also be di;erent sizes and 
colours, and you can even add special e;ects. Organisations use font formatting to 
improve the readability and presentation of documents. In the following exercises 
you are required to add font formatting to your MyFax document.

Usually documents have a consistent style, such as one type of font for headings 
and another for the main body of the text. For this exercise, you are required to 
experiment with a number of di;erent types of fonts.

Format font

1. Open your MyFax document.

2. Select a few sentences of your document. From the Home tab, make selections 
from the formatting tools for Font, Bold, Italic, Underline and Size.

 

3. Select a few other sentences from your document. Change the colour using the 
Colour tool.

4. Save your changes and close your MyFax document.
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Text alignment

Aligning text and using bullets or numbers to clearly 
separate points can improve the presentation of text.

Text alignment refers to the way the text lines up on 
the page. You can access alignment options from the 
paragraph formatting tools in the Home tab.

3ere are four alignment options available in Word:

• Align Le&

• Centre

• Align Right

• Justify

Look at the following buttons.

 

Bullets and numbering

Bullets and numbering can be used to create lists in a document. You can access 
bulleting and numbering options from the paragraph formatting tools in the 
Home tab.

A multilevel number list can be created using the Multilevel Numbered button. 
3e paragraph level can be adjusted by clicking the Increase Indent  or the 
Decrease Indent button  from the formatting tools.

Below are examples of di;erent styles of lists.

Bulleted list

 └ Here is an example:

• A bullet, such as a thick dot or hyphen, is inserted at the start of 

each new paragraph.

• Each bullet is indented.

Numbered list

 └ Here is an example:

1. A number is inserted at start of each new paragraph.

2. If you add or delete a paragraph from the list, the numbering will be 

automatically updated.

continued …
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… continued

Multilevel numbered list

 └ Here is an example:

1. Multiple features can be highlighted with multilevel numbered lists.

1.1.  These lists are good for indexes or other complex documents.

1.2. Each list level has a different indent.

2. Numbers or letters are automatically inserted.

2.1. Explore the options in the drop-down list.

Borders and shading

You can use borders and shading to organise or emphasise parts of a document. In 
Word, you can add lines, boxes and shading to paragraphs, selected text and tables. 
A border can also be used to frame an entire page. You can access borders and 
shading options from the paragraph formatting tools in the Home tab. 

Add borders and shading

In the following exercise, you will add borders and shading.

1. Open the MyFax document.

2. Select some text in the document. Select the Borders tool. 

3. From the Borders arrow, select a line type for your border (for example, All 

borders).

4. Using the same selected text, select the Shading tool. 

5. From the Shading arrow, choose a 8eme Colour.

6. Save and close your MyFax document.
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Page numbering

Page numbering is commonly used in longer documents, such as reports. It 
may also be used in outgoing correspondence, such as letters. Page numbers are 
placed in the margin of the document by using the Page Number button via the 
Insert tab.

 

3ere are a number of options for where the page number can be positioned, such 
as le& aligned or right aligned. It is possible to manually manipulate it further via 
the header and footer; for example, to add the word ‘Page’ before the number.

Tabs

Tabs are commonly used to position text horizontally on a page. Using the tab stop 
on the keyboard allows you to tab the text approximately 1.25 cm at each stop – 
this is the default option. Alternatively, it is possible to use the ruler to place the 
tab stop at the required position. Tabs can be aligned right, le&, centred or at the 
decimal.

In the following exercise, you will practise using tab stops.

1. In your MyFax document, if you do not have the ruler in view, select the View 

tab and check the Ruler. 

2. Click in a paragraph in your document.

3. Select the alignment of the tab stop using the type of tab stop on the le& of the 
ruler  . Each time you click a di;erent alignment option is selected.

4. If there are no tab stops, click into the ruler where you want the tab stop to be 
positioned.

5. To remove a tab stop, simply drag it o; the ruler.

6. To modify a tab stop, such as to add a leader (a dotted or dashed line), simply 
double-click on the tab stop on the ruler. Make alterations using the following 
dialogue box.

Click OK, then save and close your document.
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Practice task 4

1. Word process this text. Format the document using different fonts for headings and 

the main body text. Use borders and shading to emphasise text and insert a page 

number, right aligned in the footer. Save your document and name it MyActivities.

Activities for �tness

Get more play into your day. There are loads of ways to get active and have fun too. 

Go skateboarding, �y a kite, throw a frisbee or kick a ball around. Walk the dog, 

shoot some hoops or play footy with friends.

Get organised. Play football, basketball, netball, tennis, hockey, soccer or another 

sport. You could also enrol in dancing, go rollerblading, go bowling or join a swim 

team.

Get back to basics. Develop and practise basic skills like throwing, catching, 

hopping, skipping and jumping.

Warm up �rst. Start your �tness program slowly every time and gradually pick up the 

pace. Do some stretches before a run or strenuous activity.

Cool down last. As you complete your activity session, cool down your muscles by 

slowing the pace of your activity before stopping.

Prevent injuries. Make sure you always wear the right protective gear for the 

activities you choose, such as helmets, knee-pads and mouth-guards.

Work out a plan. Figure out the best time for your chosen activities, either before or 

after school, or work. Don’t waste your weekends or holidays sitting in front of the 

TV.

Miss the bus. Walk to school, ride a bike to work, rollerblade or jog to the shops. Or 

get off the train or bus a few stops early and walk the rest of the way.

Cut down screen time. Count how many hours you spend in front of the TV or 

computer and try to cut down. Sur�ng the net and sending emails can be absorbing, 

but try to limit the time you spend staring at the screen.

Get some coaching. If you show promise in a particular sport or you want to improve 

your skills, think about getting a coach, trainer or mentor. Don’t be shy; ask your PE 

teacher or local community centre.

Drink plenty of water. Drink water before, during and after each activity.

2. Can you have a different header and footer on odd and even pages?

3. Which buttons can you click to have different headers and footers within the same 

document?

continued …
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… continued

4. Which of the following is not an option on the Header and Footer Design toolbar?

 • Insert Date

 • Insert Number of Pages

 • Insert Picture

 • Page Setup

5. How does Word indicate a spelling error?

6. How does Word indicate a grammatical error?

7. Describe how you can access the spelling and grammar options.

8. As well as using a spelling and grammar checking function, what else should you do to 

prevent errors in documents?
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Screen display options allow you to manipulate and control the document while 
it is on-screen. You are able to alter the way you view the information to make it 
easier to read on-screen and enable you to visualise the document before you print 
it. Screen display options can also be used for working on a number of documents 
or programs at one time.

View options

View options provide di;erent ways of looking at your document. Each view gives 
you an alternative way to review your document. In many cases it is personal 
preference as to which view is best; however, the most common view used is Print 
Layout. 

To alter your on-screen view, from the View tab, select the appropriate button.

 

Use the view control at the bottom right of the screen to quickly adjust the view 
of the document – simply click on the appropriate option to change the on-
screen view.

 

3e di;erences in the views are as follows.

Print Layout

Allows you to view the document as it will appear when it is 

printed. Page margins and headers/footers are all in view. The 

break to a new page is obvious in this view.

Read Mode 

Hides the writing tools and menus and leaves more room for the 

pages themselves. Read Mode automatically �ts the page layout 

to your device using columns and larger font sizes, both of which 

you can adjust.

2B Identify and manipulate screen 
display options and controls
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Web Layout 

Enables you to view the document as you would view a web page. 

Page breaks, page margins and headers and footers are not 

displayed. Some people have a personal preference for working in 

this view as it has a focus on the document content.

Outline 

Allows you to view the document in outline form. This is useful 

for longer documents or reports where styles are used much 

the same as chapter headings. The Outline view allows you to 

manipulate blocks of text. In this view, you are automatically 

prompted to use a new set of tools under the Outlining tab.

Draft

Enables you to work within the document to make necessary 

adjustments to text and content. Page margins and headers and 

footers are not visible.

Zoom options

To make documents easier to read on-screen as well as to check the overall layout, 
there are various zoom options available for use. You might want to zoom in and 
increase the size of the document to see text and objects more clearly. You might 
want to zoom out and decrease the size of the document in view to analyse the text 
layout and overall document presentation.

3e zoom control at the bottom right of the screen can be used to quickly adjust 
the zoom view of a page. Simply move the control up or down to change the zoom 
size of the document.
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Access zoom options

To access zoom options, from the View tab, select a Zoom tool button as follows:

 

• Zoom: opens the Zoom dialogue box to enable you to specify the zoom level 
of the on-screen display. You can choose to check the prede/ned zoom sizes, 
or you can manipulate it by typing in a percentage or by selecting how many 
pages you want to view.

 

• 100%: zooms the document to 100 per cent – normal size.

• One Page: zooms the document so an entire page /ts in the on-screen view.

• Multiple Pages: zooms the document so multiple pages /t in the on-
screen view.

• Page Width: zooms the on-screen view so the width of the lines of text 
matches that of the window.

The ruler

 

3e ruler is used to judge where the margins, tab stops and indents are aligned 
on the page. 3e ruler enables you to see and alter their position. 3e ruler is also 
useful if you are working with tables or columns. When the ruler is turned on, 
both a vertical and a horizontal ruler are displayed.

To turn the ruler on, from the View tab, check Ruler . To turn it o;, 
uncheck it.
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Ribbons – tool buttons

 

In Microso& Word 2013, toolbars have changed signi/cantly. 3e program now 
operates by using a number of ‘ribbons’ that provide access to commonly used 
tools. You need to familiarise yourself with the various tools that are available in 
Word 2013. 

Ribbons are categorised under various heading tabs such as Home and Insert. 
Each category has a tab so you can easily switch to the di;erent tool buttons that 
you might need to use.

 

3ere are also additional tabs that may appear with groups of tool buttons that are 
relevant to an action that you are performing; for example, when you choose the 
Outline view, a new set of tools appears under an Outlining tab.

For each tab, there are groups of tools available. For instance, under the Home tab 
the available tool groups relate to:

• clipboard

• font

• paragraph

• styles

• editing.

Maximise and minimise – the document window

Maximise and minimise options are regularly used when working in any of the 
Microso& programs.

You can use minimise to ‘hide’ the document you are working with from view. 
You are not closing or saving the document, you are just putting it away from view 
for the moment. You may want to do this to view another document or program. 
To minimise the document, use the minimise button in the top right of the title 
bar . Alternatively, you can click on the document name in list of documents that 
are open at the bottom of your screen .

To maximise a document you are working with, simply click the document name 
in the list of documents that are open at the bottom of your screen . 
3is will put the document into view, and it becomes the active document that you 
are working with.

If the document window is in restore mode, it only takes up part of your screen. 
To maximise the document, use the maximise button in the top right of the 
title bar .
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Print preview 

Print preview is useful to check the layout and presentation of a document before 
you print it. It is a useful proo/ng tool and a good habit to get into to save time 
and paper. Before choosing to print a document, /rst preview the document and 
check you are happy with the way it appears on-screen.

To access print preview, from the File tab, select Print.

3e document will appear in a preview window to the right of the screen.

Practice task 5

Complete the following tasks.

1. Open the MyActivities document that you saved in the previous practice task.

2. Change the view option to Draft.

3. Check the layout and presentation of the document by using the zoom tool to view 

one page at a time.

4. If the ruler is not on, turn it on so it is in view. For one paragraph of text, place a tab 

stop at 4 cm on the ruler. Go to the start of the line and press the tab key once. The 

text should now be positioned 4 cm from the page margin.

5. Using the Home tab, format the text in one paragraph – bold, font type, size.

6. Using the Insert tab, insert a header into the document – this should include your 

name and the date.

7. Using the Page Layout tab, check the orientation of the document is portrait.

8. Minimise the document window so that it is not in view.

9. Maximise the document window and print preview the document. Make any 

alterations as appropriate and send the document to print.

10. Save and close the document.

If this task was dif�cult, revisit the sections on manipulating screen display options or 

seek advice.
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You may need to access help when producing word processed documents. You may 
not understand how a word processing so&ware function works, or you may need 
help operating a printer. Whatever the problem is, you need to have a plan in place 
for dealing with the unexpected. Organisations usually have a number of ways of 
dealing with so&ware or hardware problems. 3ey may have manuals or training 
booklets for you to look at, or they may have set up a help desk.

Using Word Help

If you are working in Word, you can use the Word Help facility . Full access 
to the help facility requires that you be connected to the internet. It is possible, 
however, to access standard help facilities oTine. To use this facility, simply click 
on it and either use the chapter index or type in a keyword for the help you need in 
the Search bar.

You can also use F1 to access the Word Help facility.

 

You can /nd out more about speci/c formatting of an on-screen document 
by using Shi& F1 on the keyboard. 3is will display character and paragraph 
formatting.

2C Overcome problems with document 
presentation and production
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Using tool buttons

Each time you move the pointer over a tool button, it will display a help bubble 
that tells you what the button is used for. For instance, from the Home tab, move 
the pointer over the font tools, and you will notice the help bubble for the Change 

Case tool button as follows:

 

Using manuals

Word processing so&ware comes with user manuals that describe the so&ware’s 
features and provide step-by-step instructions for carrying out di;erent functions. 
You can /nd manuals in paper-based and online formats. Look for paper-based 
manuals in your organisation or in your local library.

3ere are many websites where you can /nd information about Microso& ODce 
applications. 3e websites contain frequently asked questions and solutions to 
common problems. You can also download updates, tools and any /xes Microso& 
has developed for so&ware problems. You may /nd the following sites useful.

http://support.microsoft.com

This is Microsoft’s main site for �nding help to solve problems for all 

Microsoft products. You can ask questions online and download �les, 

including service packs, drivers and patches. This site also gives you 

access to the Microsoft Knowledge Base, which offers help with word 

processing problems.

http://of�ce.microsoft.com

This site provides resources for all Of�ce applications. It has news 

and announcements and useful �les that you can download. If you are 

connected to the internet, you can open this site by choosing Help in 

all Of�ce applications. You may need to click on the bottom right of the 

window to allow access to Of�ce.com.
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Using training materials

3ere are many ways to learn about computer functions and so&ware packages. 
You may have been to a training course to learn a particular computer function 
or a supplier may have instructed you on how to use a piece of equipment. You 
may have received training when you started a new job. Training courses usually 
provide a comprehensive set of instructions or notes that are worth keeping for 
future reference.

Practice task 6

Read the case study, then complete the questions that follow.

Case study

Mohana works as a personal assistant to a manager in a large organisation. One of 

her roles is to word process a variety of documents. While producing documents, 

Mohana often needs to use the Word Help facility to answer questions about use of 

the software. If she is unaware of what a screen icon’s function is, she points to the 

icon and reads the help bubble displayed.

Sometimes Mohana uses Microsoft’s support website to �nd solutions to software 

problems that cannot be solved using Word Help. There are manuals available 

in Mohana’s workplace and she has photocopied the pages she needs most 

frequently. She keeps them in a help folder on her desk.

1. If Mohana experiences software problems, where does she go for help?

2. If Mohana is unaware of a screen icon’s function, what does she do?

3. Describe how Mohana uses paper-based manuals.

4. If you experienced a software problem when producing a document, describe the 

steps you would take to solve the problem.
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Summary

1. 3e use of so&ware functions and formatting options ensures the document 
has a consistent design and layout.

2. You need to check, amend and proofread documents in accordance with 
organisational and task requirements.

3. Developing your skills in proo/ng and editing will help in the production of 
error-free documents.

4. Screen options and controls provide ways for you to check and proofread the 
document on-screen before you print it.

5. Before printing, print preview the document to ensure it suits organisational 
and task requirements.

6. Using help facilities, reference manuals and training booklets can assist in 
solving problems that occur when producing documents.
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3is learning checkpoint allows you to review your skills and knowledge in 
producing documents.

Part A

Imagine your workplace or school is about to have an a&ernoon of activities to 
help people learn to deal with disagreements. You have been asked to word process 
a Lyer that will be distributed to advertise the event. You can use the topics below 
for the activities or make up your own topics. Make sure you add the date of the 
event and where it is to be held. When word processing your document:

• use word processing formatting options to communicate your message as 
clearly as possible

• as required, use screen display options and controls to assist in working with 
and viewing the document

• use help facilities if needed

• proofread your document to check for errors

• preview your document before printing it

• save your document as ManagingDisagreementsFlyer and store it safely.

Topics (optional)

• Managing disagreements

• Handling arguments with friends

• How to break down the wall of silence

• Uncovering the true source of your arguments

• Methods for discussing your di;erences

• Ways to achieve meaningful discussions

Part B

In this activity you are required to use your ManagingDisagreementsFlyer to word 
process a report. Write one paragraph for each topic you have advertised on your 
Lyer. Use any online or paper-based help resources available to you to compete 
the task.

Learning checkpoint 2 
Produce documents
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Look at the following example of a paragraph written about one topic in the Lyer.

Handling arguments with friends

Best friends will still have disagreements just as all people do. It is how the 
disagreement is handled and how it strengthens the friendship that makes this 
friend your best friend. Friends accept each other for who they are, not what 
they have or who they know. Friends don’t try to change each other. Friends 
support each other through thick and thin. Disagreements happen, but they don’t 
last long. If you have a disagreement with a friend, try to keep the channels of 
communication open and don’t start to ignore or avoid them.

When producing your report, make sure you:

• use paragraph formatting; for example indents, spacing and margins

• format text using font size, type, colour, borders and shading

• add lists if they are appropriate

• proofread your report to make sure it has a consistent style and that there are 
no spelling or grammatical errors

• as required, use screen display options and controls for working with and 
viewing the document

• use help facilities to assist you if needed

• preview your document before printing it

• name your document ManagingDisagreementsReport and save it in a 
safe place.

Part C

Word process the information below. Make sure it delivers the intended message 
and that you do the following:

• Use formatting options to improve readability.

• Use screen display options and controls as required for working with and 
viewing the document.

• Use help facilities to assist you if needed.

• Proofread and edit your document for spelling and grammatical errors and 
consistent style.

• Print out your document and save it as ODceTips.
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Tips for workjing in an oDce

Tip: Six Traits of Leeders

Studies have indicated six traits that are consistently associated with leedership:

Ambition & energy

Desire to lead

Honesty and integraty

Self-condedence

Inteligence

Job-relavant knowledge

Tip; Deeling With Change

Change can be diDcult for many of us. For example, if you’ve been transferred 
to a new department or given a new supervisor, you will need to make some 
adjustments. Try to understand the change and how it is making you feel. Look for 
coping mechanisms that address your feelings. For example if you feel you might 
be lonely in a new department, try to /nd ways to help others and make some new 
friends.

Tip/Help Others Fit In

How can new workers be made to feel welcome on the job? It takes more than a 
tour of the oDce and an employee orientation. Find ways to include and value new 
team members. Invite them to sit in on planning and sta; meetings, look for their 
input on new projects, ask them to serve on committees. Valuing employees helps 
strengthen their commitment to the team

Tip: Blame vs. Solutions

When things go wrong on the job, ressist the urge to start placing blame, and 
pointing /ngers. Managment is usually more interested in damage control. So, add 
to your personal value and professional image by presenting viable solutions rather 
than spending a lot of time dwelling on the cause Caution Don’t, ignore the cause 
completely, as the solution may lie in understanding why the problem occured to 
begin with

Tip Take Days OA

Be sure you are familliar with your employers’ vacation and time o; policy. Yoou’ll 
want to understand how time o; acrues or when you are eligible for time o;, so 
that you won’t plan a holiday and then /nd out you are not elligible

Tip. Be Sel7sh at Work

Unsel/sh co-workers contribute to e;ectiveness and productivity in the workplace. 
By putting team goals and objectives before personal interests, teemplayers 
decrease their value to the team teem and at the same time boost their own self-
estem and condedence;
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Part D

Word process your answers to the questions below. Ensure that you apply 
appropriate formatting to enhance the layout and presentation of the document. 
Use view options and controls to assist in producing the document, and where 
needed access help facilities that are available to you. Save the document as 
MyWordProcessing, and preview it before you print the document.

How would you do the following when word processing a document?

• Change the orientation of the document to landscape

• Insert a page break

• Change the margin width for the whole document

• Alter the margin width for part of the document (for example, a paragraph)

• Insert a bullet mark

• Show paragraph marks

• Indent a paragraph

• Change the alignment of a paragraph to centre

• Change the line spacing of the document to double-spaced

• Insert a header that includes a logo on the le& side (use a Clipart picture if no 
logo is available)

• Insert the /le path of a document to the footer – centre aligned

• Insert a page number to the footer – le& aligned

• Spell check the document

• Protect a document from changes

• Change the layout of the document to be two columns

• Format text to alter the font type and size

• Add a border and shading to a paragraph

• Use the default tab stop

• Change the view option to Full Screen Reading

• Use Zoom to view document as one page

• Turn the Ruler on

• Find out what a tool button does

• Minimise the document window

• Maximise the document window

• Preview a document

• Access and use the online help facility
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Ensuring that you produce quality documents that adhere to organisational 
and task requirements is important. 3oroughly checking and proofreading a 
document before sending is necessary to ensure the correct message and corporate 
image are being delivered to the appropriate people. For example, if you have 
not spell checked a document and it contains errors, or if you use the wrong 
letterhead, it sends an invisible message to the receiver of the document. 3ey may 
think that you, and your organisation, don’t really care about the content of the 
document.

When preparing documents, it is important that you adhere to the required time 
lines and job instructions. If you believe there needs to be alterations to either the 
time line or job instructions, you will need to discuss this with your supervisor. 
Many businesses have strict deadlines for completing tasks – it may be that 
documents or reports are required for signature by the end of the week. If you fail 
to meet the deadline and don’t send out the required documents or reports, it may 
a;ect other tasks.

In this topic you will learn how to:

3A Preview, check, adjust and print a /nal document

3B Prepare documents within time lines and requirements

3C Name and store documents, and exit the application safely
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All word processed documents need to be checked to 
make sure they meet style and layout speci/cations. 
Documents also need to be checked to make sure the 
information is accurate. You have to check style and 
layout speci/cations as well as for spelling and 
grammatical errors. Word processed documents also 
require time to edit and proofread before they are 
printed, published or distributed to colleagues.

Edit and proofread

When you edit a document, you re/ne it to make sure you have written it 
in the best way possible. Editing is also used to check that documents meet 
organisational layout requirements and to identify and correct errors in grammar, 
punctuation and spelling. Proofreading means checking that the /nal document 
is the same as any dra& document you were given to copy. For example, your 
manager may give you a handwritten letter to word process. You need to proofread 
your document to make sure you have copied it correctly.

O&en, the words editing and proofreading are used for the same thing – checking 
that everything in the document is correct.

Developing a checklist may be helpful, as you can go through all the points 
that need to be considered before a /nal dra& of the document can be made. 
Using a checklist can improve the speed and eDciency of proofreading. If your 
organisation does not use a checklist, maybe you could develop one for all 
sta; to use.

Look at the following checklist for proofreading.

Spelling

Advice

Never rely entirely on the spell check function on your computer. 

It only identi�es spelling errors, not incorrect use of words. Words 

may also be spelt in different ways; for example, American and 

Australian spellings of words such as organize/organise. Check the 

style manual of your organisation or ask your manager if you are 

unsure. 

3A Preview, check, adjust and 
print a 9nal document
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Grammar

Advice

Grammar and punctuation suggestions made by software 

applications are not always correct. Check them yourself before 

choosing the change suggested.

Style

Advice

Style should be consistent. Make sure headers and footers 

are correct and spacing is consistent throughout; for example, 

‘10.30 am’ is always written in the same way (not ‘10:30 a.m.’ or 

‘10.30am’). Check the style manual of your organisation or ask 

your manager if you are unsure.

Numerical data

Advice

Match your document with the original �gures you were given 

and make sure it is accurate. It is easy to make a mistake when 

entering a lot of numerical data into a document.

Accuracy of information

It is important to ensure the contents of any documents you are producing are 
accurate. If the information contained in the document is not accurate, it can 
cause problems for the company you represent. For example, you might work for 
a builder and have been asked to send out a letter of o;er with a quoted price to a 
customer. You accidentally mistype the quoted price as $35,000, when it should be 
$85,000. 3e customer would probably be more than happy with the o;ered price; 
however, the builder would not be happy about the situation.

Taking the time to check information and make sure it is correct helps to save 
time, improve oDce eDciency and increase the prospects of customer and 
organisational satisfaction.

As part of the proo/ng process, check:

• name and address details

• product information and pricing

• dates
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• reference details (for example, catalogues and previous correspondence)

• spelling

• document-speci/c facts (for example, name of legislation and required action 
for the reader to take).

Consistency of layout

Following a speci/c format for the layout and presentation of documents helps to 
promote the image that a business is trying to portray. Having a consistent layout 
makes it easier for you because you know the prede/ned criteria for producing 
di;erent documents. Many organisations use templates to help ensure a standard 
layout is followed for the production of documents. 3e templates may already 
have paragraph formatting, font formatting, headers/footers, logos and the text of 
the document there. It may just be a case of inputting the name and address, or 
altering only parts of the content.

A consistent layout for documents boosts the image and reputation of an 
organisation. It can inLuence people’s perceptions of the professionalism of the 
correspondence, and of how serious you are about your job and the tasks you 
perform.

Follow content and format instructions

Guidelines or instructions should be used when word processing documents. 
3ese may relate to the content of the document, or its format and layout. For 
example, you may be asked to dra& a letter to a supplier about upcoming orders, 
taking care to highlight the number of orders and dates expected for future 
orders and checking the product codes before printing it on corporate letterhead. 
3ese are speci/c instructions on how to produce the 
document. Not following the instructions may delay 
the /nal production of the document and reduce the 
e;ectiveness of the letter or the information’s accuracy.

It is always important to clarify instructions if needed, 
and ask questions about what else may be needed if you 
are not sure. If you have your own ideas on how the 
content or format of a document could be improved, 
speak to your supervisor.

Print documents

Once a document has been checked for errors, you may have to print it. Before 
printing, use the preview option to see how the document will look on the printed 
page. To see the preview, select the File tab, then Print.
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Print a document

In the following exercise, you will print a document.

1. Open your MyLetter document.

2. Select the File tab, then Print. If you are unhappy with the preview, click the 
back arrow  and modify your document.

3. From the File tab, select Print. You will see a Print dialog box similar to the 
following.

4. Under the Printer heading, select the appropriate printer.

5. Under Settings, select Print all Pages. By selecting this, you will print the 
whole document. You can also choose to print selected pages from the 
document by entering page numbers into Pages; for example, 3-9 would print 
pages 3 to 9.

6. From the Copies box, select 1. You can change this option to print multiple 
copies of the same document.

7. From Print All Pages, you can choose to print only the odd or even pages. 
Click Print to print your document.

3e Collated option controls the order in which multiple-page documents are 
printed. For example, imagine you want to print two copies of a three-page 
document. If you choose Collated, Word will print the pages as follows: page 1, 
page 2, page 3 of document one, then the same for document two. If Collated is 
not chosen, the two documents would print page 1, page 1, page 2, page 2, page 
3, page 3.
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Practice task 7 

1. Proofread this document. Correct spelling, punctuation and grammatical errors to 

make it more readable. Also check for consistency of style. Word process the entire 

document with your corrections. Save your document as MyProofreading.

Porf reeding

Reading a docuemtn that has glarring speelling erors is very distracting. Bad 

punctuation, inconsistencies in text, inappropriate grammar, missing text or 

poore laid out all detract froma docuemtns readability. Therefore, all documents 

that are going to be read by anyone, other than the originator, must follow this 

golden rule - Porf It First

Make sure that your work is free from anything that could undermine the 

message you are trying to communicate: It is di�cult to proof-read your own work 

as you only see what you expect to see. Ask a colleegues or friend to profread 

any word processed doeumnt that yu have to produce.

When you are proff reeding check for:

Speelling mistakes;

Incorrect: capitalisatio

paw punctuation

Inconsistent use in style, headings, tenses, etc·

Misnumbered; sequences

formatting inconsistencies

Factual erorrs

Read the case studies, then answer the questions that follow.

Case studies

Mary is the customer service of�cer for a large bathroom supply company. She 

regularly takes calls from customers enquiring about sale items and the pricing 

of goods. She recently took a call from a customer – Tim Wood. Tim said that he 

was a regular customer and that he had seen in the local paper an antique bath 

on sale for $700. Tim asked Mary to con�rm the sale price and closing date of 

the sale in writing as he had misplaced the advert. Mary was more than happy to 

oblige and said she would have a letter out to him in the afternoon mail.

John works for a small charity organisation. Part of his job is to create a monthly 

newsletter to send out to the charity’s client base. The content and format of 

the newsletter follow a standard outline, and John’s supervisor is happy with the 

comments he has received from clients about how easy it is to read. John thinks 

the newsletter is not modern enough and has decided that he will change the 

font type and logo. He intends to send the newsletter out to the existing client 

base, as well as local businesses in the area. John believes that this will attract 

new supporters to the charity.

continued …
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… continued

2. What does Mary need to clarify to ensure that the information she sends in the letter 

is accurate?

3. What company resources could Mary have used to check details while she was 

speaking with the customer?

4. What instructions should John follow to produce the newsletter?

5. What are your opinions about John’s ideas?

6. What should John do before he makes changes to the newsletter?
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Whenever you are given a work task, you need to plan a 
time line. A time line is a plan for how long a task will 
take to complete. It also breaks the task into steps and 
details when each step needs to be completed.

Word processing a document usually involves a time 
line. 3is identi/es which tasks need to be carried out 
before the document can be completed.

Organisational time line

You will o&en be required to meet speci/c deadlines. Your supervisor may give 
you a deadline for completing a set task (for example, preparing a dra& of a letter 
by 2.00 pm), or you may have regular deadlines for common tasks (for example, 
on a monthly basis, sending letters to customers who are overdue in paying their 
accounts). It is important to the eDcient running of your organisation that these 
sorts of time lines are adhered to. If a deadline might not be met or you have 
conLicting work priorities, discuss this with your supervisor as soon as possible. 
Your supervisor may be able to assist you by suggesting how the deadline can be 
met or by agreeing to adjust the deadline.

Using a diary system and a to-do list can help you prioritise tasks and stay aware 
of the time lines required for set tasks.

Time line agreed with internal/external client

Organisations have both internal and external clients. Internal clients are those 
that work at the same organisation as you and include your work colleagues, 
people in other departments, managers and supervisors. External clients are those 
that are outside the organisation, including clients and suppliers. In many cases, 
time lines are set and agreed with your client base – both internal and external. If 
you agree to a deadline for completing a task, it is important that you meet it. Your 
supervisor may be able to make suggestions that you have not thought of to help 
you meet your deadline. Discussing the issues with the client may enable you to 
adjust the deadline. 

Meeting a deadline demonstrates your competency in undertaking tasks and also 
shows professionalism on the job. Make sure that when deadlines are being set, 
they are both achievable and realistic.

3B Prepare documents within time 
lines and requirements
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Practice task 8

Read the case studies, then answer the questions that follow.

Case studies

Thanh works as a clerical assistant and one of his roles is to produce word 

processed documents for his manager. Thanh is asked to produce a report for 

the organisation’s general meeting in two weeks. Several people in different 

departments are required to write articles for the report. Thanh also needs to write 

an article about the progress of a current project and include this in the report. 

Thanh makes a list of everyone who has to submit work for the report. He informs 

each person about the work they need to submit and when it is due. Thanh then has 

to write his own article that will be included in the report. He plans all the tasks he 

still needs to carry out. He has to talk to colleagues involved in the project, draft and 

edit his article and collect articles from colleagues.

Mae works as a customer service representative for a large telecommunications 

business. She regularly deals with both internal and external clients, and is required 

to produce documents giving product descriptions and prices of new products. With 

the introduction of new technology to the business, many more new products have 

become available. This has increased Mae’s current workload and she is �nding it 

dif�cult to meet the standard time lines for sending out the required information. 

Mae is an ef�cient worker and has always been able to produce the required 

documents before the required time lines. Because of this, her clients expect that 

they will receive the information in advance of when it is needed.

1. Explain why Thanh’s report needs time planning.

2. What do you think is good or bad about Thanh’s planning?

3. When there are a number of people involved in the production of a document, what 

kinds of things can go wrong?

continued …
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… continued

4. What should Mae do? Who should she discuss this situation with?

5. Can you suggest any systems that Mae should follow to help her meet the time lines?

6. If Mae misses the time line and doesn’t discuss it with anyone, what might be the 

reaction of the clients?
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Information is a valuable asset in any organisation. How information is stored and 
the security measures used to protect it are central to an organisation’s procedures.

3e documents you word process might be stored on a server that allows access 
by multiple users. A server is a computer that delivers information and so&ware to 
other computers linked by a network.

To enable sta; to log on to a server, the systems 
administrator issues each person with a username. 3e 
user must then create a password.

Usernames and passwords give users access to the 
information they require to complete workplace tasks 
and allow the allocation of di;erent levels of access to 
information.

Data security

You may /nd that some of the documents you word process are con/dential. Ask 
your manager for your organisation’s policies regarding con/dential material.

Data needs to be safeguarded against accidental or deliberate damage. Data loss 
is usually caused by human error or system failure. Some organisations use a data 
cartridge at the end of the day to back up the information on the database. 3is 
cartridge can then be taken o;-site for safety. If any damage occurs to the server or 
the premises, a complete backup is available.

A server holds a large number of /les and folders. Organising this information 
helps users /nd what they want. If you are saving information onto a server, make 
sure you know where to put it. Find out what your organisation’s policies are 
regarding the storage and security of word processed documents. 

Create a document to be used by previous 
versions of Word

Microso& Word 2013 has some features that are not available in previous versions. 
If you are creating a document that people with an older version of Word need to 
access, you will need to work in Compatibility Mode. Compatibility Mode turns 
o; some of the new features, which ensures that people working in older versions 
(for example, 2003) will still have full editing capabilities.

To create a document in Compatibility Mode, select the File tab, select Save As, 
and select Word 97-2003 Document in the Save As Type list.

In the /le name box, type a name for your document, and click Save. It is 
important that this is done when you /rst create the document.

3C Name and store documents, and 
exit the application safely
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Name, store and close documents

When producing word processed documents, you need to be aware of how 
to name them and where to store them. All organisations have policies and 
procedures for naming and storing documents. Ask your manager to explain your 
organisation’s requirements. Documents can be stored in so& or hard copy. 3is 
means they can be stored electronically in a computer or in paper-based form in a 
/ling cabinet.

Some organisations have strict naming standards that must be adhered to, such as 
all project /les having to start with PRO. Another example is using client reference 
numbers rather than names. If there are many clients with the same surname, a 
unique reference number will avoid confusion. Find out the naming standards for 
folders and /les in your workplace or place of study.

Digital storage

Paper documents can become damaged, yellowed and brittle. In addition, unless 
you are very careful about storage and use, important documents can be easily 
torn, mis/led or accidentally disposed of. Storing many documents can also be 
expensive and some organisations prefer to store information digitally. Digital 
storage saves on paper and space.

Another advantage of storing documents digitally is that powerful databases 
can be used to search stored information. Databases enable you to /nd speci/c 
information that would be much harder to /nd by searching through hard copies 
of documents. Databases also provide management with powerful metrics and 
reporting tools. For example, 
statistical information can 
be gathered from a database, 
and detailed reports can be 
produced.

In many organisations, folders 
and /les are stored on servers. 
Deleting old electronic /les 
and folders needs to be done 
regularly to ensure an eDcient 
use of server space. Always 
ask for authorisation before 
making any deletions.

Folder structure and naming standards

Folder structure and naming standards are needed to allow sta; to set up folders 
quickly and easily. Shared directories are folders on a network that a group of 
people have access to. 
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If you use shared directories, you need to assess whether a /le should be placed 
in the shared directory or whether it should stay on your computer’s hard drive. 
Decide which documents are for your use and which need to be shared.

Advantages of using shared directories and naming standards

 • It can prevent losing or mis�ling electronic documents.

 • Work is less likely to be duplicated.

 • It makes it easier to share information between colleagues.

 • Documents on the same or related subjects are located together, which helps people 

�nd and retrieve documents.

Shared directories

To set up a shared directory, you must /rst allocate a shared network drive. Your 
IT coordinator can help with this. 3e /rst place to organise a directory is at the 
folder level. Folders have a treelike structure that branches from a parent directory 
to sub-folders in a hierarchical structure. 

Look at the following example.

In this structure, the server has three folders for three separate work groups: 
Group A, Group B and Group C. Group C has three major folders: Procedures, 
Personnel and Projects. 3e Projects folder includes Project A, Project B and 
Project C. Project C has two documents: ProjectC_timelines.doc and ProjectC_
research1.doc. 3e /le path for retrieving a document starts at the server and ends 
when the correct document is located. For example, to reach ProjectC_timelines.
doc, the /le path to follow is:  
C:\GroupC\Projects\ProjectC\ProjectC_timelines.doc.
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Document properties

As well as using user-friendly naming and saving conventions and adhering 
to organisational requirements, it can be helpful to use document properties 
to record common information about a document. Document properties help 
describe or identify a document, and include details such as title, author name, 
subject and keywords that state the document’s topic or content. 3e information 
contained in document properties can also be used when conducting a search for 
/les on your computer.

To access properties, select the File tab. Info opens by default. Hover your pointer 
over the property you want to update and enter the information. 3e dialogue box 
below will be displayed to allow you to enter the required details.

Back up 9les

Many organisations have set procedures for backing up /les. In many large 
organisations, this is administered through the IT department and is an automatic 
process. In this case, the only thing you need to do is ensure you save your /les to 
the appropriate network drive and folders.

In smaller organisations, it may be necessary for you to back up /les; this may 
be done on a daily or weekly basis. If this is the case, check with your supervisor 
about back up procedures.

Backing up /les is an important procedure because it helps prevent the loss of 
documents and information, and is extremely useful in case something happens 
to the network or computer system and you still want to retrieve previous 
documents.
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Hard-copy storage

Many documents stored digitally are also stored in hard copy. 3is safeguards 
against a computer system failure. Hard-copy storage requires space and the 
establishment of a /ling system that uses consistent, simple and meaningful names 
similar to those used in digital storage.

Hard-copy documents need to be kept up to date. 
Managing hard-copy documents is necessary as storage 
space in organisations is o&en scarce and valuable. 
Old or superseded documents should be destroyed 
on a regular basis according to organisational policy. 
Retention schedules list the timeframe that documents 
need to be kept before they can be destroyed. Documents 
without permanent value may be scheduled for eventual 
destruction. Find out what kind of hard-copy /ling 
system is used at your workplace or place of study.

Close applications

A&er creating or modifying an electronic document, you need to exit the so&ware 
application without causing damage or loss to data. Data loss can occur when a 
computer program stops performing its expected function. O&en the program, or 
even the whole computer, may appear to freeze. All computer users will experience 
data loss at some time and will be unable to access data. Data may have been 
accidentally erased or corrupted and made inaccessible. Below are a number of 
precautions you can use to prevent data loss, but keep in mind the main cause of 
data loss is human error.

Work on one document at a time

 └ Try to work on only one document at a time. If you need to work 

with multiple applications open, you should close applications 

when they are no longer needed. This will help your computer 

work more quickly and will prevent data loss in the event of 

computer failure.

Lock unattended workstation

 └ Data loss can occur if someone else tampers with your work. If 

you are working on a document at your workstation, you need 

to lock your computer or exit the application before leaving your 

workstation unattended.

continued …
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… continued

Use virus protection 

 └ Other causes of data loss include virus damage, operating 

system or application software bugs and failed upgrades. Using 

virus protection programs and frequently updating software can 

help prevent data loss.

Prevent computer malfunction

 └ If your computer starts to make unusual noises or display warning 

messages, shut it down immediately and do not turn it back on 

until you have received advice from an IT coordinator.

Use the correct application exit procedure

 └ To exit the program, select the exit button, which is located in the 

top right corner of the window. If you have recently made changes 

to your document, you will be prompted to save changes.

Practice task 9

Read the case studies, then answer the questions that follow.

Case studies

Matthew works as an of�ce administrator in a large organisation. His duties 

include formatting reports and saving them on the server. He is also responsible 

for backing up the server at the end of each day. At the end of a busy day, Matthew 

had completed several reports for different departments within the organisation. 

He had to save each of them in a different location, and it took him a while to work 

out where they all belonged. He wasn’t sure if he had saved them all in the correct 

place. After this, he was running late and decided not to back up the server. The next 

morning, the reports that Matthew had saved were needed for an important board 

meeting. However, during the night a virus had infected the server, destroying all the 

information from the previous day.

Fred has retired from an organisation after working as an administrative assistant for 

10 years. The areas Fred was responsible for were accounts and projects. The day 

after he retired, someone needed a �le that Fred had created and stored. The �le 

contained vital accounting information. It was discovered that Fred had saved more 

than 500 �les in a variety of folders and the �le could not be located. The folders 

had ambiguous names such as Folder1 and Folder2 and the �les had names such as 

august1.doc and march2.doc.

continued …
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… continued

1. What would be the consequences if Matthew did not save some of the reports in the 

correct place?

2. Can you think of any consequences of not backing up data on the server?

3. Describe why Fred’s folder and �le naming system failed.

4. Fred was responsible for two areas. What could he have done to make sure �les could 

be easily located?

5. Explain why folder and �le names should be consistent, simple and meaningful.
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Summary

1. To ensure the production of quality products, it is important to thoroughly 
check and proofread the /nal document.

2. Documents produced need to adhere to organisational and task requirements.

3. It is necessary to follow agreed time lines and instructions.

4. Not meeting time lines or following instructions can have a negative impact on 
the organisation.

5. Following appropriate /le referencing and saving options makes it easier to 
locate documents.

6. Many organisations follow strict conventions for the storage and saving of 
documents.

7. Following organisational backup procedures reduces the chances of document 
loss.
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3is learning checkpoint allows you to review your skills and knowledge in 
producing documents.

Part A

Produce a word processed document for a workplace. It can be your own 
workplace, or one you are familiar with. 3e document can be any type of 
document outlined in Topic 1. When producing your document, make sure you:

• use the organisation’s style and layout speci/cations for the type of document 
you are producing – use word processing functions and formatting options to 
achieve the required result

• check the document for spelling and grammatical errors

• work within a time line set by your manager

• preview and check the document

• make any necessary adjustments before printing it

• save the document in the correct folder

• exit the program.

Part B

Word process the following text. Make three dra&s of the text using di;erent 
formatting styles and layouts. Each document should have its own consistent style, 
but the documents should be very di;erent from each other. Be as creative as 
you can with your formatting styles and layout. Remember that the main aim of 
formatting is to make the document easy to read. 

• Check the documents for spelling and grammatical errors.

• Preview and check the documents.

• Make any adjustments before printing them.

• Save the documents to an appropriate /le path and name your documents 
CallCentre1, CallCentre2, CallCentre3.

• Exit the program.

Types of call centres

3e way a call centre is organised di;ers from one call centre to another. Some 
call centres divide their services very clearly into sales and customer service, with 
an operator dealing exclusively with either sales or service support. Some large 
centres have created di;erent sections to deal with di;erent aspects of a product, 
so when a customer calls, the call is sent directly to the specialist.

Learning checkpoint 3 
Produce documents
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Inbound calls

Some call centres – known as inbound call centres – handle only incoming 
calls and specialise in providing information or service to customers. Customer 
service calls may involve customers calling to ask a question, requesting help 
with a problem, complaining about a product or service, or asking for technical 
assistance. 3e kind of call depends on the purpose of the call centre.

Outbound calls

Some call centres handle only outgoing calls. 3ese types of calls involve activities 
such as market research, selling, surveying customer satisfaction levels or soliciting 
for donations. Just as with incoming calls, the types of calls depend on the purpose 
of the call centre.

Part C

Read the case study, then answer the questions that follow.

Case study

Lauren has recently commenced work as a receptionist for a small hotel. Her duties 

include word processing tasks, such as formulating letters and short reports. Lauren 

has been asked to prepare the minutes of the managers’ meeting. Actions that each 

manager has agreed to and due dates for their completion need to be highlighted, as 

well as summarised as a type of check-sheet. Lauren has been asked to complete the 

�nal document by the end of the day and distribute it to the managers. There is a shared 

network system that all managers and Lauren have access to.

8. What type of layout should Lauren use to prepare the minutes? What can she 
do to ensure that it is consistent with the layout of previous minutes?
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9. What should Lauren do to proofread and check the /nal document?

10. What is Lauren’s deadline for completing the task? Are there any additional 
instructions for Lauren to follow before she can say she has /nished the task?

11. Where should Lauren save the document? What should she name it so it is 
easily accessible?

Part D

Word process your answers to the following questions. Preview, check and adjust 
the document before printing. Allow yourself one hour to complete this task and 
ensure you have recorded your name and date in the header. Before exiting the 
program, /le the document appropriately and name it MyAnswersTopic3.

1. What does editing a document mean?

2. What does proofreading a document mean?

3. When checking for accuracy, what are three details you might need to check?



94
Unit release 2 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU201
Produce simple word processed documents

4. What is the importance of a consistent layout?

5. In a workplace, why is it necessary to follow instructions and time lines?

6. If you needed to print only page 2 of a four-page document, how would you  
do this?

7. If you needed to print multiple copies of a document, how would you do this?

8. Why do you need to follow organisational requirements when saving and  
naming /les?

9. If you sent a sales letter to Ms Ha Nguyen (customer no. 33487), what would be 
an appropriate /le name?

10. How do you exit Word?
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